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1. Start Client for Office and personalize the
interface

Managing Teamcenter content using the Client for Office interface

Teamcenter Client for Microsoft Office gives you direct access to Teamcenter through Microsoft Office
Word, Excel, PowerPoint and Outlook. You can manage Teamcenter workspace objects in real time
using the Microsoft work environment, which allows more people throughout the extended enterprise,
including partners and suppliers, to participate in product lifecycle processes.

Word Outlook
[ ]
Excel PowerPoint

In Microsoft Office Word, Microsoft Office Excel, Microsoft Office PowerPoint, and Microsoft Outlook,
Client for Office adds a custom Teamcenter tab to the ribbon in the main windows. In both Microsoft
Outlook, the ribbon in each open message contains the custom Teamcenter tab.

Client for Office is independent of the Teamcenter rich client. You can work in Client for Office with or
without the rich client running.

Client for Office can be installed with Teamcenter or separately as an add-in.

Caution:

To import requirement structures directly from Microsoft Office Word, you must select the
Teamcenter Office for Microsoft Client->Word Applications>Requirements Management
Integration option when installing Client for Office.
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_ 1. Start Client for Office and personalize the interface

Note:

With Teamcenter Extensions for Microsoft Office, or live Excel, you can make live synchronous
updates to Teamcenter objects using Excel. If Extensions for Office is loaded, you cannot edit an
embedded Excel spreadsheet in a Word document. You must disable the Teamcenter Office Live
for Office add-in in Excel.

To disable the add-in, do the following in Excel:
1. Choose File=»>Options and click Add-ins.
2. Select COM Add-ins to manage and click Go.

3. Inthe COM Add-ins dialog box, clear the check box next to the Teamcenter Office Live for
Office add-in and click OK.

Office file types supported by Client for Office

Client for Office gives you direct access to Office documents that are stored in Teamcenter. You can work
in Client for Office without running the Teamcenter rich client.

Use Client for Office to work with Office documents of the following types.

Office application File types

Word .docx, .doc,.dotx.dot, .mrk or .html
Excel Xlsx, .xls,.xItx.xIt, or .html
PowerPoint .pptx, .ppt,.potx.pot, or .html
Outlook .msgx, .msg, or .pdf

If your system is configured to handle file types such as JPEG, GIF, PNG, and PDF files, you can view them
using the Office client. To open such a file, right-click the dataset, choose View File, and select the file to
open.

Start Client for Office for the first time

The first time you start an Office application after the Client for Office installation, the Microsoft Office
Customization Installer displays a message stating that Siemens Digital Industries Software is the
publisher and asking if you want to install the customization. You need to click Install to install the
Teamcenter add-in for the application.
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Change your group or role _

After you install the add-in, Client for Office provides the following additions to the following Office suite
of products.

Office product Client for Office addition
Microsoft Office Word A Teamcenter tab is incorporated in the Office
Microsoft Office Excel ribbon.

Microsoft Office PowerPoint
Microsoft Office Outlook

Microsoft Outlook The Teamcenter tab is available on the ribbon in
each open message.

Before you can access any of the functions for the Teamcenter add-in, you are prompted to log on to
Teamcenter. Depending on whether Security Services is configured on the Teamcenter server, one of the
following displays:

* The Teamcenter logon page displays if Security Services is configured.

* The logon dialog box displays if Security Services is not configured.
Personalizing the interface by updating user settings

Change your group or role

1. On the Teamcenter tab, click Current Settings 42 and choose Session.
The Session dialog box is displayed.

2. Select the new group in the Group list.

3. Select the new role in the Role list.

4.  Click OK.

Set your work context

A work context is a profile that a user assumes to complete a specific assignment. Work contexts are
created from a combination of user name, group, role, and project; however, not all definitions of a work
context include all four of these elements.

For this option to be available, the TC_wc_show_all preference must be set to true, and one or more
work contexts must exist in Teamcenter.

1. On the Teamcenter tab, click Current Settings 42 and choose Session.
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_ 1. Start Client for Office and personalize the interface

The Session dialog box is displayed.
2. Select the new work context in the Work Context list.
3. Click OK.
Set your project or program assignment
1. On the Teamcenter tab, click Current Settings {2 and choose Session.
The Session dialog box is displayed.
2. Select the project in the Project list (or Program, if the ADS template is installed).
3. Click OK.
Change the Client for Office display language
1. On the Teamcenter tab, click Current Settings 42 and choose Basic Teamcenter Preferences.
In the Miscellaneous pane, Change Session Culture is displayed.

2. Select the new language from the Choices list, and then click OK.

Setting Client for Office document preferences

Changing Client for Office document settings

Client for Office preferences let you control the way you work with Office documents.

Note:

These preferences are specific to Client for Office. They do not relate to Teamcenter user
preferences and site preferences.

On the Current Settings button {2: menu, the Basic Teamcenter Preferences option displays the Basic
Teamcenter Preferences dialog box, where each tab contains different options.

* On the Miscellaneous tab, you can set options for language and color theme. Advanced settings
allow you to manage temporary files.

* Change Session Culture displays the current language setting and a list of language choices.

* Change Color/Theme displays the current color setting and a list of color choices.
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Changing Client for Office document settings _

* Advanced settings displays Manage Temporary Files options where you can:
m Select the option to automatically delete all temporary files (older than one week).
m Launch Explorer to manage log files.
m Launch Explorer to manage temp files.

On the Insert Data tab, you can set the type of Teamcenter data to insert in Office documents for
individual object types.

e Folders

e |tems

* [tem revisions

* Microsoft Office files
* Image files

Note:

Bitmap image files (.bmp) cannot be inserted in Microsoft Office Word documents with
Teamcenter live Word capability.

e JT files
e Forms
¢ Other Teamcenter files

Depending on the object type, you can set an option to insert one of the following:
* Object properties in tables with columns and rows
The Details option sets this preference for the related type.
* Hyperlinks to objects (except forms) in the Teamcenter web client.
The Hyperlink option sets this preference for the related type.
* Embedded contents of Office files, image files, and JT files

The Embed option sets this preference for the related type.

Note:

Bitmap image files (.bmp) cannot be embedded in Microsoft Office Word documents with
Teamcenter live Word capability.
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_ 1. Start Client for Office and personalize the interface

Note:

Some options are not available for some types.

* On the Insert Details tab, you can set the property columns to insert for the object types that you set
with the Details option.

Configure how Teamcenter objects are inserted

1. On the Teamcenter tab, click the Current Settings button & and choose Basic Teamcenter
Preferences.

The Basic Teamcenter Preferences dialog box displays.

Note:

These preferences are specific to Client for Office. They do not relate to Teamcenter user
preferences and site preferences.

2. Click the Insert Data tab and select an option under Configuration Choices for one or more object

types.
Option Description
Details Insert object properties in tables with rows and columns.
You can also set the property columns to insert.
Hyperlink Insert hyperlinks to objects in the Teamcenter web client.

Note:

* The Hyperlink option is not available for objects in the Teamcenter
rich client or for forms in the web client.

* The Hyperlink option is controlled by certain Teamcenter
preferences configured for your site. These site preferences are not
the same as any of the Client for Office preferences.

If you have questions about this option, consult your Teamcenter
administrator.
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Configure data display _

Option Description

Tip:

You can choose from the options in the Basic Teamcenter
Preferences dialog box, in the Additional Options section to
configure the display of hyperlinks.

Embed Insert the full contents of the files.

Note:

* The Embed option is available only for Microsoft Office documents
and image files.

* You cannot insert bitmap image files (.bmp) in a document with
Teamcenter live Word capability.

3. Do one of the following:

* Click Apply to commit the settings and continue working on another tab.

Caution:

Changes are canceled if you click another tab before you click Apply.

* Click OK to commit the settings and close the dialog box.
Configure data display

1. On the Teamcenter tab, click the Current Settings button {5 and choose Basic Teamcenter
Preferences.

The Basic Teamcenter Preferences dialog box displays.

Note:

These preferences are specific to Client for Office. They do not relate to Teamcenter user
preferences and site preferences.

2. Click the Insert Details tab and do one or more of the following:

» To add a property to the inserted table, select the check box to the left of the column name in
the dialog box.
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_ 1. Start Client for Office and personalize the interface

» To remove a property from the inserted table, clear the check box to the left of the column name
in the dialog box.

* To move a property to the left in the inserted table, drag the column name up to the
corresponding position in the dialog box.

* To move a property to the right in the inserted table, drag the column name down to the
corresponding position in the dialog box.

* To change a displayed property name, double-click the cell under Column Name and type the
new name.

3. Do one of the following:
* Click Apply to commit the settings and continue working on another tab.
Caution:
Changes are canceled if you click another tab before you click Apply.
* Click Defaults to use the default column settings.

* Click OK to commit the settings and close the dialog box.
Specify whether hyperlinks point to the rich client or to the web client

You can configure which client (rich client or web client) hyperlinks are generated for.

Note:

You can configure this only if the system administrator has configured the system to allow users to
modify this setting.

To do so:

1. Open the Client for Office application. In the Teamcenter tab, click the Current Settings button {&&
and choose Basic Teamcenter Preferences.

The Basic Teamcenter Preferences dialog box is displayed.

Note:

These preferences are specific to Client for Office. They are not related to Teamcenter user
preferences and site preferences.
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Configure the display of hyperlinks in documents _

2. Inthe Miscellaneous tab, in the Advanced Settings section, select the Link to Rich Client check
box if you want hyperlinks to be generated for the rich client. To generate hyperlinks to the web
client, clear the Link to Rich Client check box.

3.  Click Apply.
Configure the display of hyperlinks in documents

You can customize how hyperlinks are displayed when inserted into a document. Specifically, you can
choose whether to include an item ID/revision, item name, or both to be used as the hyperlink text. You
can also specify an icon to be displayed in the hyperlink.

Hyperlink configuration selections persist untill you change them.
To configure the display of hyperlinks:

1. In the Client for Office, in the Teamcenter tab, click the Current Settings button ¢5: and choose
Basic Teamcenter Preferences.

The Basic Teamcenter Preferences dialog box is displayed.

Note:

These preferences are specific to Client for Office. They are not related to Teamcenter user
preferences and site preferences.

2. Inthe Insert Data tab, in the Additional Options section, select an option for the hyperlink text:
* Show icon
Displays an icon at the beginning of the hyperlink.
* |[tem ID
Displays the item's ID in the hyperlink text.

For example, if you select only Item ID, the hyperlink is displayed as follows:

014461/A;1

¢ Iltem Name

Displays the item's name in the hyperlink text.
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_ 1. Start Client for Office and personalize the interface

For example, if you select only Item Name, the hyperlink is displayed as follows:

Myltem

If you select both Item ID and Item Name, the hyperlink is displayed as follows:

014461/A:1-Myltem

Note:

To ensure that a hyperlink contains at least minimal identifying information, the hyperlink
text must have either the item ID/revision or the item name.

3. Click Apply.

Set up the automatic deletion of log files and temporary files after a specified
number of days

You can configure the deletion of log files and temporary files after a specified number of days if the
system administrator has not already configured these settings by adding the autodelete section to the
config.template file.

To configure the deletion of log files and temporary files after a specified number of days:

1. Open the Client for Office application. In the Teamcenter tab, click the Current Settings button &%
and choose Basic Teamcenter Preferences.

The Basic Teamcenter Preferences dialog box is displayed.

Note:

These preferences are specific to Client for Office. They do not relate to Teamcenter user
preferences and site preferences.

2. Inthe Miscellaneous tab, in the Advanced Settings section, in the Manage Log and Temporary
Files section, check the Automatically delete all Log files older than the following number of
days checkbox and specify the number of days after which you want the log files to be deleted. To
specify the automatic deletion of temporary files, check the Automatically delete all Temporary
files older than the following number of days checkbox, and specify the number of days after
which you want the log files to be deleted.

3.  Click Apply.




Exit Client for Office _

Exit Client for Office

1. On the Teamcenter tab, click Current Settings ¢ and choose Logout.

The Teamcenter tab is available on the Office ribbon in the Word, Excel, PowerPoint, and Outlook
main windows and in open Outlook messages.

Client for Office displays a message asking if you want to end this session.

2. Click Yes.

Note:

This action closes all open Client for Office views and terminates the existing Teamcenter
session.
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2. Searching in Teamcenter

Run a simple search

Caution:

Siemens Digital Industries Software recommends that the Office ribbon be fully visible. If the
ribbon is minimized when the search is started, it may result in an error. If the Office ribbon is
minimized, right-click the ribbon tab name area and turn off the Minimize the Ribbon option.

You may minimize the ribbon again after the Advanced Search view appears.
You can search using predefined search types.

* In the Navigation view or the Folder View, the item identifier is the default search query at the top of
the view. Type an identifier of the item that you want to find.

* Change to a different query type by selecting one from the list:
* Search By—>Item ID
* Search By—~>Item Name
* Search By—>Dataset Name

After you enter your search criteria, click search [0 to display the results in a new tab of the Advanced
Search view.

Run an advanced search
1. Choose one of the following:
* On the Teamcenter tab, click Search [0 to display the Advanced Search view.

* In the Navigation view or the Folder View, click * next to the Enter Item ID box and choose
Advanced Search.

2. On the Queries tab, scroll the pane until you see the query that you want, and then select it.

Information boxes and lists that are specific to the query type are displayed in the Custom Query
Form pane. A description of the query is shown below the Select Query Type pane.

3. Inthe Custom Query Form pane, enter information to narrow your search.
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_ 2. Searching in Teamcenter

You can click Clear to remove all existing information from this pane.
4.  Click Find.

The Advanced Search view displays the results on a new tab. In this view, each tab name indicates
the type of query that produced the results.

You can right-click an object and choose menu commands that are specific to the object type.
* Choose Properties to view the properties in the Property Display view.

* Choose Refresh to get updated property values from Teamcenter.

* Choose Check-In/Out to display the Teamcenter Check-In/Out view.

* Choose Insert to insert the object's attributes in the open Office document.

* Choose Delete to delete the object from Teamcenter.

* Choose New Workflow Process to submit the object to a workflow.

* Choose Open File (Read-Only) to open the object in the corresponding Office application and
view the content in read-only mode.

* Choose Open and Check-Out File to open the object in the corresponding Office application and
check out the object for editing.

5. To save the query:
a. Click Save to open the My Saved Searches tab.
b.  Type a name for the search in the Saved Search Name box.
c.  Click Add to save the search.
The search appears in your My Saved Searches folder.

d. Right-click the query in your My Saved Searches folder and choose Execute Query to
perform the search.

6. Toremove a tab of search results, select the search results tab you want to remove and click
Delete.

7. To specify a new search, click Queries to return to the Queries tab.
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Save a search
1. Do one of the following:
* On the Teamcenter tab, click Search [0 to display the Advanced Search view.
* In the Navigation view or the Folder View, do the following:
a. Click the down arrow to the right of the box at the top of the view to display a list.
b. Select Advanced Search to display the Advanced Search view.
2. On the Queries tab, select the query type and enter custom query form criteria.
3. Click Save to display the My Saved Searches tab.
4. Type a name for the search in the Saved Search Name box.
5. Click Add to add the new search to the My Saved Searches list.

The search name appears under My Saved Searches in the Navigation view. You can run a search
from this view by right-clicking the search and choosing Execute query. Results are shown on a
new tab in the Advanced Search view.

Run a saved search

From the Navigation or Folder view
1. Todisplay your searches, do one of the following:
* In the Navigation view, click My Saved Searches.
* In the Folder View, expand My Saved Searches.
2. Right-click the search and choose Execute query.

In the Navigation view, you can also rest the pointer on the search to display a right arrow, and
then click the arrow to start the query.

From the Advanced Search view
1. Todisplay your searches, do one of the following:

* On the Teamcenter tab, click Search [0 to display the Advanced Search view.
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_ 2. Searching in Teamcenter

* In the Navigation view or the Folder View, click * next to the Enter Item ID box and choose
Advanced Search.

2. Inthe Advanced Search view, click the My Saved Searches tab.

3. Select the search from the My Saved Searches list, and click Find.

Delete a saved search

1. Do one of the following:
* On the Teamcenter tab, click Search [0 to display the Advanced Search view.
* In the Navigation view or the Folder View, do the following:
a. Click the down arrow to the right of the box at the top of the view to display a list.
b. Select Advanced Search to display the Advanced Search view.
2. Click the My Saved Searches tab.
3. Select the search in the My Saved Searches list, and then click Delete.
A message asks you to confirm that you want to delete the search.
4. Click Yes.

The search name is removed from under the My Saved Searches node in the Navigation view.
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3. Working with Teamcenter objects from
Client for Office

Tasks you can perform using the Teamcenter tab on the Office
ribbon

The Teamcenter tab on the Office ribbon gives you direct access to Teamcenter data. The tab buttons
display various Client for Office panes in the Office application windows.
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Data Management button group
Navigation and View button group
Tasks button group

Workflow button group
Requirements button group
Attribute Exchange button group
Settings button group

00 N o U1l AW N =

Help button group

Use these panes to work with Teamcenter objects without running the Teamcenter rich client. You can:
* Browse to and search for Office documents and other Teamcenter objects.

* View the properties of Teamcenter objects.

* Check out and check in Office files in Teamcenter.

* Create, edit, save, and delete Office files in Teamcenter.

* Create Teamcenter folders, items, and item revision objects in Teamcenter.

* Revise item revisions.

* Insert Teamcenter object property values, search results, pictures, JT files, and hyperlinks in Office
files.
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_ 3. Working with Teamcenter objects from Client for Office

* Review Word documents using the Teamcenter Markup Manager view to work with markup
comments.

* View and mark up PDF files from Microsoft Outlook.
* Digitally sign PDF files from Microsoft Outlook.
* Submit Office files to Teamcenter workflows and perform Teamcenter sign-off tasks.

* Configure attribute exchange settings to synchronize Teamcenter object attributes and Office file
properties.

* Import data from Excel to create and modify structures and objects in Teamcenter.

* Manage Teamcenter requirements.

Navigate and browse Teamcenter objects
1. From the Office application, click the Teamcenter tab—>Navigation and View group—>Navigate =.
2.  Choose one of the following options:

* Folder View

In the Navigation-Folder View pane, click the - button beside the Teamcenter object or folder
you want to expand.

Navigation - Folder View v X

Enter Iltem ID_.. ( A Y

4 ApHome

8 Mailbox
4 &= Newstuff

" Doc1

) Pdf1

- Part1

* Browse

In the Navigation pane, choose any of the following options to expand the folder or the
Teamcenter object:

* Click the folder or the object.
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* Click the p button next to the folder or Teamcenter object.

* Click the folder or Teamcenter object location at the top of the pane to navigate up and down
the folder structure.

Navigation v X

[ Enter Item ID . L -

Start > Home > Newstuff
W J Doc1

-ﬁ PDF1

| Part1

#

Move and copy Teamcenter objects

In the Navigation-Folder View pane, you can move and copy Teamcenter objects.

When you move an object, you remove it from one location and place it in another. For example, you
can move an Office file from one item revision to another. It no longer is stored with the original item
revision, only with the target item revision.

When you copy an object, you create another instance of the same object in a new location, so you then
have two different instances of the same object. For example, you can copy an object from a workflow
task to an item revision. The object remains with the workflow task but is also stored with the item
revision.

1. From the Office application, open, navigate to, or search for the Office file object you want to
move or copy using the Navigation-Folder View pane.

2. Right-click the object, and choose one of the following:
* Cut: To move the object from one location to another.
* Copy: To create a new instance of the object at an additional location.

You can select multiple objects of the same type by using the standard Windows multiselect
functions.

3. Right-click the location where you want to move or copy the object, and choose Paste.
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Delete Teamcenter objects

1. Click Teamcenter tab—>Navigation and View group->Navigate £ button and choose Folder View
or Browse to navigate for the objects you want to delete.

2. Select the objects you want to delete.
You can select multiple objects of the same type by using the standard Windows functions.
* Folders
* |tems
* Datasets
* Workflow tasks
3. Right-click the selection and choose Delete.
Client for Office displays a confirmation message, asking if you want to delete the selected objects.

4. Click Yes.
Reserving Teamcenter objects

Checking out and reserving Teamcenter objects

By checking an object out of Teamcenter, you reserve access to the object so that only you can modify it.
Only your Teamcenter system administrator can override that reservation.

Tip:
In the Teamcenter rich client, the symbol for the checkout displays when you select the document
and choose Tools—>Refresh.

You retain explicit checkout privileges on the object until you do one of the following:
* Check in the object to unlock it in Teamcenter.

When you are finished with your modifications, checking in the object releases it so that it is available
to other users.

* Cancel the checkout to release the object.

If you modify the object and then cancel the checkout, changes are discarded.
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* Transfer the checked out object to another user.

If you have an object checked out, you can transfer the check out to a different user so that user can
make modifications to the object. The new user needs to check the object in after the modifications
are complete so it is available to other users for checkout.

Note:

The Transfer Check-Out option is unavailable for objects that are not checked out.

Also, you can view the checkout and checkin history of an object. A checkout history lists such
information as the users who have checked out the object and when, the object's current reservation
status, and any comments provided about the checkout operations.

Limit or eliminate the checkout confirmation

You can control the visibility of the checkout confirmation dialog by setting certain Teamcenter
preferences.

The Check-Out confirmation dialog box is displayed when the Confirm_checkout_suppressed
preference value is false.

If the Check-Out confirmation dialog is displayed, you can optionally display the Don’t show
confirmation dialog again check box when:

* The Confirmation_shown_on_reservation_dialogs preference value is true.

* Set this preference value to false if you do not want to show this check box option when the
Check-Out confirmation dialog is displayed.

Note:

If the Don’t show confirmation dialog again check box is checked by the user, this automatically
and permanently sets the Confirm_checkout_suppressed preference value to true. Thus, future
run time sessions will honor this choice. To set the Confirm_checkout_suppressed preference
value back to false, use the Teamcenter client of your choice to edit the preference value.

The Check-Out confirmation dialog box is permanently suppressed (not displayed) when the
Confirm_checkout_suppressed preference value is true.

If you have questions about preferences, consult your Teamcenter administrator.
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Check out an Office file object

1.

1.

From the Office application, open, navigate to, or search for the Office file object you want to
check out from Teamcenter.

Tip:

A 17 symbol displayed next to the file indicates that it is already checked out. To see which
user owns the reservation, you can select the object and do one or both of the following:

* Click Check-In/Out 1] on the Teamcenter tab, and choose Check-Out History.

* Click Properties (i) on the Teamcenter tab to display the Properties Display view.

The Checked Out By value shows the user.

Do one of the following:

* Select the Office file object that you want to check out, and then on the Teamcenter tab, click
Check-In/Out (T, and choose Check-Out.

* Right-click the Office file object you want to check out, and then choose Check-In/Out->Check-
Out.

The Check-Out dialog box appears.

Note:

Teamcenter preferences can be set to bypass the Check-Out dialog box.

In the Change ID box, type an optional identifier for the checkout.
In the Comments box, type an optional reason for the checkout.

Click OK to confirm the checkout.

Tip:

A T7 symbol appears to the right of the Office file name in the Folder View. The file is locked
in Teamcenter and can be modified only by you while you have it checked out.

Transfer a checkout to another user

From the Office application, open, navigate to, or search for the Office file object for which you
want to transfer the check-out to another user.
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2. Do one of the following:

* Select the Office file object that you want to transfer, and then on the Teamcenter tab, click
Check-In/Out [Ty, and choose Transfer Check-Out.

* Right-click the Office file object you want to transfer, and then choose Check-In/Out->Transfer
Check-Out.

The Transfer Check-Out dialog box appears.

3. From the Users List, select the user you want to transfer the checkout to.

Tip:

Use the Filter User List to find a user's name in the list. For example, to find John Smith,
begin typing Smith in the box, and the Users List displays matching names.

The user's name appears in the New User box.

4.  Click Yes to transfer the checkout or No to cancel.

Check in an Office file object

Note:

To see the symbol for a checked out object [T} in the Teamcenter rich client, you may need to
select the object and choose Tools—>Refresh.

1. From the Office application, open, navigate to, or search for the Office file object you want to
check in.

You can select and check in multiple objects simultaneously.
2. Do one of the following:

* Select the Office file object that you want to check in, and then on the Teamcenter tab, click
Check-In/Out (T, and choose Check-In.

* Right-click the Office file object you want to check in, and then choose Check-In/Out—Check-In.

The Confirm Check-In dialog box appears with a message asking if you want to continue with the
checkin.

3. Click Yes.
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The [Ty symbol is removed from the right of the object's name in the Folder View. The object is
unlocked in Teamcenter.

Tip:

In the Teamcenter rich client, the [Ty symbol displays when you select the document and
choose Tools—>Refresh.

Cancel a checkout for an object

Caution:

If you modify a checked out object and then cancel the checkout, your modifications are not
applied in Teamcenter.

1. From the Office application, open, navigate to, or search for the Office file object for which you
want to cancel the check-out.

You can select multiple objects simultaneously.
2. Do one of the following:

* Select the Office file object, and then on the Teamcenter tab, click Check-In/Out [Ty, and choose
Cancel Check-Out.

* Right-click the Office file object, and then choose Check-In/Out->Cancel Check-Out.

The Cancel Check-Out dialog box appears with a message asking if you want to cancel the
check-out.

3. To continue, click Yes.

Warning:

This action reverses any changes to the object since it was last checked out.

The [Ty symbol is removed from the right of the object's name in the Folder View. The object is
unlocked in Teamcenter.

View the checkout history of an object

1. From the Office application, open, navigate to, or search for the Office file object for which you
want to view the checkout history.

2. Do one of the following:

3-8



Opening Office files to view or to edit them _

* Select the Office file object, and then on the Teamcenter tab, click Check-In/Out , and choose
Check-Out History.

* Right-click the Office file object, and then choose Check-In/Out->Check-Out History.

The Check-Out History dialog box appears with a property table containing the following information
for each transaction:

e Date/Time shows when the transaction occurred.

* Activity shows whether the transaction was a checkout, a checkin, a canceled checkout, or a
transferred checkout.

e User shows the user ID under which the transaction occurred.
* Change ID shows the transaction's identifier, if entered by the user.

* Comment shows an explanation of the transaction, if entered by the user.

Opening Office files to view or to edit them

You can open Office files stored in Teamcenter from the Office applications. You can open and check out
the Office file to edit the document or open the Office file for read-only to browse the document.

You can open Office files using any of the following methods:
* From the Office application, click the Teamcenter tab—>Data Management group—>Open [¢}.
This method requires the file type must match the Office application that you are running.

* From the Office application, click the Teamcenter tab—>Navigation and View group—->Navigate 2
and choose Browse or Folder View.

* From the Office application, click the Teamcenter tab—>Navigation and View group-Search (0.

Using this method, you can open any supported Office file type from any of the Office applications.
For example, if you are running Word, you can open a Word, Excel, PowerPoint, or Outlook file.

Depending on your access rights to the Office file, the following buttons on the ribbon under the
Teamcenter tab in your Office application become available when you open a document:

* Save

* Save As ("}
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Check-In/Out Ty

Markup 5

Note:

This option is only in Word.

New Workflow Process =

Attribute Exchange
Open an Office file using the Open button
This method requires that the file type to open must match the Office application that you are running.

The following file types can only be opened from the specified Office application.

Office application File types

Word .docx, .doc,.dotx.dot, .mrk or .html
Excel Xlsx, .xls,.xItx.xlIt, or .html
PowerPoint .pptx, .ppt,.potx.pot, or .html
Outlook 2010 .msgx or .msg

1. From the Office application, click the Teamcenter tab->Data Management group—>Open [(7.

2. On the left side of the Teamcenter Open dialog box, navigate to the folder that contains the Office
file you want to open.

3. Ontheright side of the pane, select the Office file that you want to open or type the name in the
File name box in the Open file from Teamcenter pane.
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[I; Teamcenter Open EI@
4 A% Home Mame Type COwiner Group 1D
_il Mailbox ) REQ-0 MSWordX  yytcadm (yytcadm)  Engineering
@ Mewstuff

| REQ-I MSWordX  yytcadm (yytcadm) Engineering

*4 REQ-000002-00x o &' REQ-2 MSWordX  yytcadm (yytcadm)  Engineering

"l | T | -

Open file from Teamcenter

File name: ||
File of type: [NI Application Types (* docx,* doc,* dotx, v]

| Open vJ[ Cancel ]

4.  Click = next to the Open button.
5. If you want to edit the Office file, perform the following steps:
a. Choose Open and Check-Out File.

b.  From the Check-out dialog box, optionally type a change reason and change the ID and click
OK.

The document associated to the Office file is opened for edit in an Office application window.

Note:

If you do not click * next to the Open button, clicking the Open button automatically
opens and checks out the Office file for edit. If you do not have write access to the file, a
dialog box appears asking if you want to open the file for read-only access.

c. If you want to open the Office file for read-only access, choose Open File (Read-Only).

The document associated to the Office file is opened for read in an Office application window.
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Open an Office file using the navigation options

Note:

Using this method, you can open any Office file from any of the Office applications. For example, if
you are running Word, you can open a Word file, Excel file, PowerPoint, or Outlook file.

If the Office file is attached to a worklist item in your My Worklist folder, you can only open the
attachment in read-only mode.

From the Office application, click the Teamcenter tab->Navigation and View group—>Navigate = and
choose one of the following options:

* Browse
1. In the Navigation pane, navigate to the Office file by clicking the object or folder name you want
to expand.

2. To open the Office file for read access, click p next to the Office file or right-click the file and
choose Open File (Read Only).

Navigation v X

Enter Item ID... ( 4 Y

Start > Home > Newstuff
" Doc1
" Doc2 b

" Doc3

The document associated to the Office file is opened in an Office application window with
read-only access.

3. To open the Office file for editing, right-click the file and choose Open and Check-Out File.

The document associated to the Office file is opened in an Office application window with edit
access.

As the example shows, a [T next to the file indicates it is checked out for edit.

Navigation v X

Enter Item ID... ( 4 Y

Start > Home > Newstuff
" Doc1
¥ Doc2
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" Doc2 [T
* Folder View

1. In the Navigation-Folder View pane, navigate to the Office file by clicking beside the object
or folder you want to expand.

2. Right-click the Office file and choose Open and Check-Out File to check out and edit the file or
Open File (Read-only) to view the file in read-only mode.

The document associated to the Office file is opened in an Office application window with the
appropriate access.

As the example shows, a [T next to the file indicates it is checked out for edit.

Navigation v X

Enter ltem ID_. O 4

4 AkHome

8 Mailbox
4 &= Newstuff
¥ Doc1
¥ Doc2 [Ty
Open an Office file using search

Using this method, you can open any Office file from any of the Office applications. For example, if you
are running Word, you can open a file in Word, Excel, PowerPoint, or Outlook.

1. From the Office application, click the Teamcenter tab->Navigation and View group—->Search (0.

2. From the Advanced Search dialog box, select Dataset for the query type and type the values for
the fields in the query form to filter your search.

3. Click Find to search.

4.  From the results list, right-click the Office file and choose Open and Check-out File to check out
and edit the file or Open File (Read-only) to view the file in read-only mode.

The document associated to the Office file is opened in an Office application window with the
appropriate access.
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Insert Teamcenter data in an Office document

Note:
* Client for Office settings control what kind of data is inserted for a given Teamcenter object
type.

* Bitmap image files (.bmp) cannot be embedded in a Microsoft Office Word document with
Teamcenter live Word capability.

1. Open the Office file in which you want to insert Teamcenter data.
2. Place the cursor at the insertion point in the open Office file.

3. Inthe open Office file application, using an option in the Teamcenter tab, Navigation and View
group, navigate to the Teamcenter object containing the data to insert.

The object you insert can be of one of the following types:
* Folders

* Items or item revisions

* Forms

» Office files

* Image files

Caution:

You cannot insert bitmap image files (.bmp) in a document with Teamcenter live Word
capability.

o JT files

4. Right-click the object and choose Insert.

The data appears at the cursor location in the Office file.

Saving Office files in Teamcenter

Overview of saving Microsoft Office files in Teamcenter

Use Client for Office to work with Microsoft Office files content in Teamcenter to:
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* Save changes to existing Office files that you open from:
* The Teamcenter rich client
* Client for Office
* Create new Teamcenter objects from:
* External Office files such as locally stored Word documents, for example

* Existing Office files in Teamcenter

Save changes to an existing Teamcenter object

Caution:

If the file is currently open in read-only mode, you must close the file and reopen it in edit mode.
Otherwise, your changes are saved to a new file.

You cannot switch to edit mode by checking out the file while it is open in read-only mode.
* To open the file for editing, right-click the file and choose Open and Check-Out File.

* In the Teamcenter rich client, the symbol for the checkout displays when you select the
document and choose Tools—>Refresh.

1. With the file open for editing, click Save |Z] on the Teamcenter tab.

Note:

* If the Save button is unavailable, the open document is not a Teamcenter object.
To save changes in Teamcenter, you must click Save As (™}, and choose Dataset.

* If the file is not checked out, a confirmation message asks if you want to check out and
save the file.
Click Yes to display the Check-Out dialog box.

* In the Teamcenter rich client, the symbol for the checkout displays when you select the
document and choose Tools—>Refresh.

» Teamcenter preferences can be set to bypass the Check-Out dialog box.

* When saving a Microsoft Word document to Teamcenter, wait for the background save of
Microsoft Word to complete. Especially for large documents this may take a considerable
amount of time. To enable you to quickly save the document to Teamcenter, you can
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temporarily disable the Allow background saves option. To do so, in Microsoft Word,
choose File->Options—>Advanced. Scroll to the Save section and deselect the Allow
background saves option.

A status message displays a progress indicator.
2. When a confirmation message asks if you want to check in the file, do one of the following:
* To check in the file and commit your edits, click Yes.

The check mark is removed from the right of the file name in the Navigation view and the
Folder View.

* To keep the file open for editing, click No.

The check mark remains to the right of the file name in the Navigation view and the Folder
View.

Note:

Before checking in a Word document that already contains the markups, in the Teamcenter
tab, always click Markups > Save/Extract so that the markups can be extracted to
Teamcenter.

Use Save As to create a new Teamcenter object
1. With the source document open, click Save As [} on the Teamcenter tab, and choose Dataset.

The Teamcenter Save As dialog box appears.

2. To create a new folder where you want to save the new Teamcenter object, perform the following
steps:

a. Click Create a new Folder [g at the top of the Teamcenter Save As dialog box.

b. Inthe Create New Folder dialog box, navigate to and select a location where you want to
create the folder.

By default, the destination folder location is set to the location you selected in the tree pane
located on the left side of the Teamcenter Save As dialog box.

c. Inthe Folder Name box, type the folder name.

d. Optionally, type a description of the folder in the Description box.
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Click OK to create the folder and close the dialog box or click Apply to create the folder and
leave the dialog box open.

The folder is created under the specified location.

To create a new Teamcenter item object, perform the following steps:

J-

Click Create a new Item [ at the top of the Teamcenter Save As dialog box.

In the New item dialog box, navigate to and select a location where you want to create the
item.

By default, the destination folder location is set to the location you have selected in the tree
pane on the left side of the Teamcenter Save As dialog box.

Click the button * next to the Item Type box and select the item type from the list.
Click Next.

Click Next or select Item Information on the left side of the dialog box to enter the required
item information.

Optionally, click Next or select Additional Item Information on the left side of the dialog box
to enter the additional item information.

Optionally, click Next or select Item Revision Information on the left side of the dialog box to
enter the item revision information.

Optionally, click Next or select Additional Item Revision Information on the left side of the
dialog box to enter the additional item revision information.

Click Finish to create the item.
The item is created under the specified location.

Click Close to close the window or click Next to create a new item.

To create a new revision of a Teamcenter item revision object, perform the following steps:

a.

b.

In the tree pane located on the left side of the Teamcenter Save As dialog box, navigate to
and select the item revision you want to revise.

Click Revise an item revision in Teamcenter(™, at the top of the Teamcenter Save As dialog
box.
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c. Inthe Rev ID box, optionally type the new item revision ID, or use the value automatically
generated from Teamcenter.

d. Inthe Name box, optionally type the new name of the item revision or use the value
automatically generated from Teamcenter.

e. Click OK to create the new item revision.

5. Inthe tree view, navigate to and select the location where you want to save the Teamcenter object.

Note:

If you do not select a location, the object is added to the Newstuff folder.

6. Type the object name in the File name box.
You can also do the following:
* Type a description in the Description box.
* Select the file type in the Save as type list.
7.  For the Relation option:
a. Select the parent folder or object to which you want to save the dataset.
The default relation type is selected.
b. If necessary, select a new relation type from the list.
8.  Click the Save button to close the dialog box.
A status message displays a progress indicator.
The new object is saved in the selected location or in the Newstuff folder.

9. Inthe Confirm Check-Out dialog box, click Yes if you want to check out the Teamcenter object and
associated Office file for edit.

Create or revise Teamcenter objects using Client for Office

Create a Teamcenter folder

Teamcenter folders are data objects that you use to organize product information. Folders can contain
any other information object, including other folders.
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1. Navigate to and select the location where you want to create the folder.

For example, you can use the Folder View by clicking Folder View E on the Teamcenter tab.

Note:

If you do not select a location, the folder is added to the Newstuff folder.

2. Onthe Teamcenter tab, click New (¥) and choose Folder.

Note:

You also right-click the target location and choose Create Folder.

The Create New Folder dialog box displays.
3. Type the folder name in the Folder Name box.
You can also type an optional description in the Description box.
4. Do one of the following:
* To close the dialog box, click OK.
The new folder appears in the selected location or in the Newstuff folder.

* To keep the dialog box open and continue to create folders in the same location, click Apply.

Create a Teamcenter item

Note:

When you create a new item, you create the item and its first item revision.

1. Navigate to and select the location where you want to create the item.

For example, you can display the Folder View by clicking the Teamcenter tab—->Navigation and
View group—~>Navigate == and choosing Folder View.

Note:

If you do not select a location, the item is added to the Newstuff folder.

2. Onthe Teamcenter tab, click New (¥) and choose Item.
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The New Item wizard displays, beginning with the Select Type window.

In the Item Type list, select the type of item to create, and then click Next to display the Item
Information window.

Note:

You can select an item type that uses cascading and interdependent lists of values (LOVs), if
the Teamcenter administrator configured such item types in the Business Modeler IDE.

If you have questions about item types and LOVs, consult your Teamcenter administrator.

In the Item ID and Revision ID boxes, type the identifiers to assign to the item and revision.

Tip:
To automatically generate the item and revision identifiers, click Assign.

The next identifiers in the sequence appear in the Item ID and Revision ID boxes.

Type a unique name in the Name box.

You can also do the following:

* Type an optional description in the Description box.
* Select a value from the Unit of Measure list.

* If a Microsoft Office document is created with the item, select the Automatically Open
Document check box to check out and open the document simultaneously.

Note:
* The item type can be configured with a corresponding document under Item Revision
Definition Configuration (IRDC).

* The document format must match the Office application in which you are creating the
item.

Click Next to display the Item Revision Information window.
In this and subsequent windows, the information is specific to the item type you select.

If you have questions about information for the item type, consult your Teamcenter administrator.
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Note:
* If the item type uses a cascading LOV (an LOV with subordinate LOVs), your value selection
at one level determines the value choices that are available at the next lower level.

* If the item type uses an interdependent LOV (a type of cascading LOV), you are prompted
for a value selection at each level.

7. Inthe Item Revision Information window and each subsequent window, enter the required
information and any optional information, and then click Next.

8. To complete the procedure, click Finish.

The new item and item revision are added to the selected location or to the Newstuff folder.

Revise a Teamcenter item revision

Note:

When you revise an item revision, you create a new item revision. The new one automatically
receives the next revision identifier in the sequence.

1. In the Office application, click the Teamcenter tab—>Navigation and View group—>Navigate =
and choose Folder View or Browse.

2. Inthe Navigation view or the Folder View, navigate to the item revision.
3. Right-click the item revision and choose Revise.

The Revise Item Revision dialog box appears. The Rev ID box set to the next revision identifier in
the sequence.

4. Do any or all of the following:
* Change the item revision name in the Name box.
* Enter or change the optional description in the Description box.

* Select a project in the Available Projects for Assignment box.

Note:

The following information is read-only:
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* Contents displays the names of the objects included in the new item revision.
* ID displays the identifier of the related item.

* Rev ID displays the next revision identifier in the sequence.

5. Click OK to commit your changes and close the dialog box.

The new item revision appears below and at the same level as existing item revisions.

Maintaining Teamcenter object data and properties

Introduction to maintaining Teamcenter object data

Client for Office interacts with HTML stylesheets maintained on the Teamcenter server to display the
information in the Properties Display dialog box for a Teamcenter object. The displayed information and
the actions you perform on the object from the Properties Display dialog box are dependent on the
Teamcenter object that you select for the transaction. For example, if you display the properties for a
part revision and have the appropriate access to the object, you can perform such actions as revising the
object and sending the object to a workflow.

You also have the option of checking out objects and modifying any editable properties. After modifying
the object properties, you can save the object, check in the object, or cancel the checkout directly from

the Properties Display dialog box.

Note:

Internet Explorer must be updated to version 9 or above for style sheet support. If an older version
of Internet Explorer is installed, you receive a warning message indicating Teamcenter will display
the legacy properties dialog box. The legacy properties dialog box provides viewing of property
data only.

Client for Office Properties Display dialog box

The following figure shows the layout of the properties information in the Client for Office Properties
Display dialog box. In this example, the properties for a part revision are displayed.
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Properties

Preview

The tabs shown are dependent on the Teamcenter
object you are displaying properties for. Tabs, such as
Overview, Attachments, and History are displayed, as
needed and as configured, to organize information about
the selected object. You click on the tab to display the
additional information. The example shows the tabs for a
part revision object.

Displays the Teamcenter properties for the object. If
you check out the object, you can modify the editable
properties.

Displays the associated 2D preview image for the object if
one exists or the thumbnail for the Teamcenter object.
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_ 3. Working with Teamcenter objects from Client for Office

4 Actions Displays the actions that you can perform on the
Teamcenter object. The location of the action buttons
vary based on the objects selected.

5 Options for checking out and If you have the appropriate access, you can check out the
checking in the Teamcenter Teamcenter object. After the checkout, you can perform
object. any of the following options:

* Check in the object to Teamcenter and save all
changes.

* Save the object to save all changes. Object will remain
checked out to you.

* Cancel the checkout to discard all changes and the
checkout.

How to maintain and view Teamcenter object data

1. From the Office application, navigate to the Teamcenter object that you want to maintain or view.

Note:

Internet Explorer must be updated to version 9 or above for style sheet support. If an
older version of Internet Explorer is installed, you receive a warning message indicating
Teamcenter will display the legacy properties dialog box. The legacy properties dialog box
provides viewing of property data only.

2. Perform one of the following methods to display the Teamcenter object data in the Properties
Display dialog box:

* Right-click the Teamcenter object in the Navigation- Folder view or the Navigation view and
choose Properties.

* If the object is already open in the Office application, click Properties (i) on the Teamcenter tab.

The Properties Display dialog box appears and is populated with the properties and other data
associated with the selected Teamcenter object.

Note:

The information and the actions you can perform are dependent on the Teamcenter object
you have selected and your access permissions to the object.

3. Inthe Properties Display dialog box, perform any of the following actions:
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* Click the Overview tab to display and edit properties.

* Click More Properties to display all the additional properties.

Note:

You must check out the Teamcenter object to modify the editable properties.

* Click on any of the remaining tabs to display additional information.
* Under the Actions heading, click any of the actions you want to perform on the object.
* Click Check-out to check out the object for edit.

If the object is checked out, you can modify any editable property values and then perform any
of the following:

* Click Save to save all changes and leave the object checked out.
* Click Check-in to check in the object to Teamcenter and save all changes.

* Click Cancel to discard all changes and cancel the checkout.

Tip:

If the Properties Display dialog box is already displayed for an object, you can select a different
object and then the properties for that selected object appear in the dialog box.

Assign and remove objects from projects
1. From the Office application, click the Teamcenter tab->Navigate = —>Folder View.

2. Inthe Navigation - Folder View pane, right-click the object(s) you want to assign to a project, and
choose Assign/Remove Project.

3. Inthe Project Assignments dialog box, select one or more projects from the Available Projects
for Assignment list.

4.  Click (¥) to add the selected projects to the list.

5. Toremove a project assignment, select the project in the Current/Pending Project Assignments,
and click (=).

6. When you are assigning a folder to a project, the Contents and Folder options are displayed in the
dialog box. Select one of the following:

3-25



_ 3. Working with Teamcenter objects from Client for Office

* Contents: Only the contents (first-level objects) of the folder are assigned to the selected
projects.

* Folder: Only the folder is assigned to the selected projects.

* Both Contents and Folder: Both the contents of the folder and the folder are assigned to the
selected project.

* Neither Contents nor Folder: No objects are assigned to the selected project.

Click OK to complete the project assignments.
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Creating and modifying objects with imported Office data

Note:

Client for Office import features support only versions 2010 and 2013 of Microsoft Office Word
and Excel.

Client for Office works through Microsoft Office Word and Excel for exchanging Teamcenter data such as
requirement specifications, functional models, and logical models.

For example, your project may employ an outside contractor to design a logical model of an
implementation solution. To submit that architecture for approval or modification, the contractor can
define its structure in Word or Excel and send the file to you for potential import to Teamcenter.

By importing the data from a Word or Excel file, you create or modify the structure in Teamcenter.

e If the structure does not exist in Teamcenter, it is created from the data.

Note:

For a product structure, only imprecise assemblies can be created.

* If the structure exists in Teamcenter, the Teamcenter structure is updated:
* New objects and properties in the data are added to the structure.

* Changes in the data are applied to the latest working revisions of the corresponding objects in the
structure.

» Existing objects and property values not represented in the imported data are removed from the
structure.

Note:

Objects that are removed from a structure remain in Teamcenter.

Note:

* Only imprecise structures are created using Client for Office.
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_ 4. Importing Teamcenter data from Microsoft Office

» Absolute occurrences and incremental changes are not supported.

* The import process does not configure structures in Teamcenter, for example, by defining
revision rules. Only the latest working revisions are updated.

Note:

The Excel import feature is available only for the four-tier Teamcenter rich client.

Importing structures from Microsoft Word

How Word styles determine structure hierarchy in Teamcenter

You can create an entire requirement structure in one action by importing a specification document from
Word. Teamcenter uses the document’s Word heading styles to generate a new structure in the Systems
Engineering Requirements view. Together, the sequence of heading styles and their numbered outline
levels (1 through 9) determine the parent, child, and sibling hierarchy in the imported specification.

For example, assume that you create the following requirement specification:

(W] & = - & 4 |= Functional Requirements for Robot.docx [COHHIitrMnde]-MiunsoHWQrd lE"El'“
“ Harme Insert Page Layout References Mailings REviEw View =7 9

]
-

* 1 + Robot-Functional Requirementsq]
The-robot-shall- function-as-described- in-the-following-requirements.- 4|

" 1.1~ Park-Dimensionsy
The-robot-shall- be-capable-of-navigating: a-park-where-: the- maximum:- dimensions- are-200-by-150-feet. 1

1.2+ Par'I{-Luyout‘lTo

The-robot-shall-function-in-an-environment- similar- to-the-example- below.-1)

=]
DL
E:ﬂ
"1.2.1 + Grass-layout

The-rabot-shall- be-able-tonegotiate-various-grass-heights- throughout- the-whole-season.-Spring/Fall:- 1-
inch.-Summer:- 2.5inches.

" 1.2.2 + Concrete-Pathy i
The-robot-shall- be-capable-ot-being-able-to-navigate: on-concrete-walkways. - The-tire-tread-shall- be-able-
to-withstand- 1000-miles-of-travel-before-needing: to-be-replaced.q

1 Word document name
2 Word Heading 1 style (outline level 1)
3 Word Heading 2 style (outline level 2)
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4 Word Heading 2 style (outline level 2)
5 Word Heading 3 style (outline level 3)
6 Word Heading 3 style (outline level 3)

When you import the previous example document, Teamcenter generates a matching specification in
the Requirements view:

& 006033/A;1-Functional Requirements for Robot X S 1 1 B
Create @ Name >r Name Here> TyPe PVLION_RegSpec ~ V]
Requirement Number | Body Cleartext

A:1-Functional Requirements for Robot
TREQ-003423/A;1-Robot Functional Requirements (View) |1 o
= REQ-003424/A;1-Park Dimensions 11
Q-003425/A;1-Park Layout (View) 1.2
——=% REQ-003426/A;1-Grass layout
G,* REQ-003427/A;1-Concrete Path

he robot shall fur
he robot shall be
he robot shall fur
he robot shall be
he robot shall be

1 The name of the Word document becomes the name of the new requirement specification. By
default, the requirement specification object occupies the top level of the structure.

Tip:

You can change the top-level object type by editing the
TcAllowedimportExportPeakSpecObject preference.

2 The text of the first heading becomes the name of the first new requirement. The heading
style’s outline level places the requirement at the first level below the specification.

3 The text of the second heading becomes the name of the second new requirement. The
heading style’s outline level places the requirement at the second level as a child of the first
requirement.

4 The text of the third heading becomes the name of the third new requirement. The heading
style’s outline level places the requirement at the second level as a sibling of the second
requirement.

5 The text of the fourth heading becomes the name of the fourth new requirement. The heading
style’s outline level places the requirement at the third level as a child of the third requirement.
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6 The text of the fifth heading becomes the name of the fifth new requirement. The heading
style’s outline level places the requirement at the third level as a sibling of the fourth
requirement.

7 In the Number property column, each value matches the numbered outline level of that

requirement’s heading in the Word document.

All Word content below a given heading style becomes the content of the corresponding requirement.
Requirement content can include elements such as graphics and tables.

Note:

The Body Cleartext property column displays only the text portion of the content.

Caution:

* Special characters in Word heading styles are replaced by question marks (?) in the imported
requirements. If those requirements later are exported to Word, the question marks are included
in the output document.

* If the document does not begin with a Word heading style, the import process generates
a requirement named NO TITLE immediately below the top-level object. This requirement
receives all content from the beginning of the document to the first Word heading style, or the
entire content if there is no heading style.

Generating separate requirements within a Word outline level

Note:

Teamcenter Extensions for Microsoft Office must be installed on your computer.

Within an outline level in the import document, further separation of requirements can be achieved
through keywords. You can enter one or more keywords in the Import Spec wizard when you import a
requirement specification.

Starting with the first Word heading style, the parser searches the body content for the keyword or
keywords.

* If one keyword is found before the next outline level, the requirement starts after the nearest outline
level preceding the keyword:

* The text of the immediately preceding outline level paragraph becomes the requirement name.

* All material under the outline level paragraph becomes the requirement content. The paragraph
itself does not appear in the content.
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* The requirement has the subtype that you assign.

* If two or more keywords are found before the next outline level, the requirements are separated as
follows:

* The first requirement starts after the nearest outline level preceding the first keyword.

* The second requirement starts after the nearest paragraph separator preceding the second
keyword. This requirement is created as a child of the first requirement.

* For each subsequent keyword, the nearest preceding paragraph separator begins the requirement,
which becomes a child of the first requirement and a sibling of the preceding one.

Note:

If keywords are found within the same content paragraph, sentence separators are used
instead of paragraph separators. If two or more keywords are found in the same sentence,
a requirement is created only for the first keyword.

The name of each requirement is the text of the immediately preceding outline level paragraph. All
requirements have the same subtype, which you assign.

Note:

Keywords in tables are ignored. Separate requirements are not created for this content.

If no keyword is found in the content before the next heading style the heading text becomes the
requirement name, and contains all material under that heading. The document heading does not
appear in the requirement content.

At the next outline level, the parser repeats the processing described.

Import a structure from a Word document

Note:

Client for Office import features support Microsoft Office Word versions 2010 and 2013 only.

Caution:
* In the import document, verify that the outline levels of the Word heading styles match the
intended object hierarchy of the new structure.

* To parse the document by keywords, Teamcenter Extensions for Microsoft Office must be
installed on your computer.
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1. With the import document open, choose Specifications—->Import on the Teamcenter ribbon.

Note:

If the Teamcenter Login dialog box displays, enter your Teamcenter user name and
password, and then click Login.

The Import Specification dialog box displays.

Note:

In the Select Specification Type list, you can accept the default value, RequirementSpec, or
you can select another specification type.

You can exclude specification types from the list.

2. Do one of the following:

Parse the document by
outline levels only

Parse the document by
both outline levels and
keywords

3. Click Import.

Select Import as single subtype.

In the list to the right, select Requirement, Paragraph, or a
custom subtype defined in your Teamcenter environment.

The selected subtype is assigned to each new requirement in the
specification.

Select Use keywords for import.
The Keywords box and the = list become available.

Type the keyword or keywords in the box.

Note:

» Use a comma to separate two keywords.

» Special characters and partial words are not supported.

In the = list, select the subtype to assign to each new
requirement in the specification.

In Systems Engineering, the top-level object in a structure is a requirement specification object.
Below the specification object, parent, child, and sibling requirement objects occupy structure
levels determined by the outline levels in the import document.
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Previewing a requirement structure in Client for Office
Preview a requirement structure prior to import

Before you import a requirement structure from Word to Teamcenter, you can preview the structure in
the Client for Office Requirements pane. This enables you to determine if the document is structured
correctly before you actually import the data to Teamcenter.

You can preview Word documents with structure parsing or keyword parsing:

 Structure parsing parses the word document by using the Heading styles to set the requirement
structure levels and requirement types.

* Keyword parsing parses the word document based on keywords to set the requirement structure
levels and requirement types.

In the preview document, you can:
* Navigate the requirement structure by clicking on the nodes in the document.

* Make the necessary changes to the structure, such as changing the requirement level or object type,
before importing the requirement to Teamcenter.

Note:

Changes that you make in the preview document apply only to the preview structure. The original
document and structure remain unchanged.

Example:

As the following figures shows, the preview document displays the Requirements pane
containing the previewed requirement structure.
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If you have previewed a document and want to make further modifications, perform the following steps:

1. Close the previewed document.

2. Open the document and make the required changes.

3.

Preview the document.

Process for previewing a requirement structure prior to import

Previewing a requirement structure prior to import is part of a four-step process:

=

. Create reqguirement

structure in Word

S

2. Proview
requirement
structure

3. Make changes to
preview document
and save to disk

4. Import preview
document to
Teamcenter
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1.  Create the requirement structure in Word.

2. From Word, preview the requirement structure to display what the requirement structure will
look like when it is imported into Teamcenter. The new preview document has the text -Preview
appended to the original file name.

3. Make any required changes to the preview document and optionally save the preview document to
disk using a different file name.

From the preview document, you can make the following changes to the requirement structure
before importing:

Add or delete requirement objects.

» Copy or move requirement objects.

Reorder the requirement structure by demoting or promoting requirement objects.

Change the requirement type for a requirement object.

Assign a requirement ID to a requirement object.

Note:

If you do not assign a Teamcenter ID, the ID is automatically generated for the requirement
objects by the Teamcenter import process.

Note:

Changes apply to the preview document only. The original document is not affected.

4. Import the preview document to Teamcenter.

When you import the preview document to Teamcenter, the requirement structure is created in
Teamcenter.

Previewing a requirement structure using structure parsing

When you preview a document by using structure parsing, you use the Heading styles in Word to set
requirement structure levels and requirement types. You set the requirement object type that you want
to use for the headings.
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Structured documents contain the heading levels needed to define the structure. When you preview a
structured document, the requirement levels in the preview document are determined by the heading
level position.

Example:

The following example shows previewing a structured document with headings using the
Requirement object type as the type for displaying the headings in the preview document.

e
Original document
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1.2 Park Layout A
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Unstructured documents do not contain heading levels or numbered paragraphs.

Example:

The following example shows previewing a document with no headings using the Requirement
object type. Because the document contains no headings for determining requirement-level
positions, all the content is lumped into one requirement.
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Previewing a requirement structure using keyword parsing

When you preview a document by using keyword parsing, you use keywords to set the requirement
structure levels and requirement types. You specify the keywords and the corresponding requirement
object type you want to create for the numbered paragraphs containing the keywords.

Note:

For object types that are created from keyword parsing, the Move Up, Move Down, Promote, and
Demote commands are not available for editing the preview document.

Example:

The following example shows using the should keyword to specify the content in the Word
document to be assigned the Requirement object type in the preview document. The resulting
preview document displays all the paragraphs in the original document containing the should
keyword as Requirement object types in the preview document.

Teamcenter Client for Microsoft Office, Teamcenter 2412 4-11
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How to preview a requirement structure

Caution:

you want to connect to Teamcenter.

and then click Login.

When you open an offline Word document containing a structure, click Yes when a message asks if

If the Teamcenter Login dialog box is displayed, enter your Teamcenter user name and password,

1. On the Teamcenter tab of Word's Office ribbon, select Specifications—>Preview Structure.

The Preview Specification dialog box is displayed.
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2. Inthe Select Specification Type list, select the requirement specification type that you want to use
for the preview.

The default requirement specification type is RequirementSpec.

Note:

When you are connected and logged in to Teamcenter, the Select Specification

Type list displays custom subtypes if they are added as values of

the TCAllowedChildTypes_RequirementSpec and TCAllowedChildTypes_Requirement
preferences.

3. For structured parsing, perform the following steps:
a. Select the Preview as single subtype option.

b.  Click the » button in the box next to the Preview as single subtype option and choose the
object type you want to use for previewing the objects located under the specification.

W preview Specification m

Select Specification Type ?Requlremen:Spec -

- Preview as single subtype xﬂequuemen: =

.t Use keywords for Preview

Keyword = | Requiremsnt

| [ pven ] | f

The default object type for the subtype is Requirement. You can change the object types after
the preview document has been generated.

Note:

When you are connected and logged in to Teamcenter, the list displays custom subtypes
if they are added as values of the TCAllowedChildTypes_RequirementSpec and
TCAllowedChildTypes_Requirement preferences.

4.  For keyword parsing, perform the following steps:
a. Select the Use keywords for Preview option.

b. In the Keyword box, type the keywords you want to use to set the requirement object type for
the paragraphs containing the keywords.
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Use a comma to separate keywords.

c.  Click the ¥ button in the box next to the Keyword box and choose the object type you want

to use for previewing the objects containing the keywords.

_"_l_‘i Preview Specification

Select Specification Type RequirementSpec -

() Preview as single subtype Regquirement

(@) Use keywords for Preview

Keyword | should, as = | Requirement -

Preview | | Cancel

The default object type for the type specified by the keywords is set to Requirement. You can
change the object types after the preview document has been generated.

Note:

When you are connected and logged in to Teamcenter, the list displays custom subtypes
if they are added as values of the TCAllowedChildTypes_RequirementSpec and
TCAllowedChildTypes_Requirement preferences.

Click Preview to generate the preview document for the requirement structure.

A new window is displayed with the preview document. The preview document includes a
Requirements pane in which the requirement structure appears.

The file name for the new preview document has the text -Preview appended to the original file
name.

Navigate and edit the requirements structure in the preview document, as needed.

Save any changes to the preview document.

Note:

To commit the changes to Teamcenter, you must import the preview document to
Teamcenter.
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Editing a preview document

Add or delete requirement objects

1. In Word, generate a preview document for the requirement structure.
2. Toadd a new object with a specific type, perform the following steps:

a. Inthe preview document, right-click the target object location in the Requirements pane
where you want to add a new requirement object and choose (¥) New...

b. Inthe Create New dialog box, for the object type, click the + button and choose the object
type you want to use for the new object.

c. Inthe Name box, type the name of the new object.
d. Click OK.

The new object appears below the target object in the Requirements pane and in the
document.

3. Toadd a new object using the same type as the target object, perform the following steps:

a. Inthe preview document, right-click the target object location in the Requirements pane
where you want to add a new requirement object, and then choose (*) New.

The new object appears below the target object in the Requirements pane and in the
document using the same type as the target object.

4. Toremove an object from the requirement structure:

a. Inthe preview document Requirements pane, right-click the object that you want to remove
from the structure and choose Mark for Deletion.

A red strike-through marks the following:
* The selected object in the Requirements pane.
* The related content in the Word document window.

* All lower level objects in the Requirements pane and their content in the document
window.
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Note:

The marked objects are removed from the structure when you commit changes to
Teamcenter.

Copy or move requirement objects

In Word, generate a preview document for the requirement structure.
To copy a requirement object, perform the following steps:

a. Inthe preview document Requirements pane, right-click the requirement object that you
want to copy and choose Copy.

b. Inthe preview document Requirements pane, right-click the location in the structure where
you want to copy the requirement object, and then choose Paste.

The requirement object is copied to the specified location in the structure.
To move a requirement object, perform the following steps:

a. Inthe preview document Requirements pane, right-click the requirement object that you
want to move and choose Cut.

b. Inthe preview document Requirements pane, right-click the location in the in the structure
where you want to copy the requirement object and choose Paste.

The requirement object is moved to the specified location.

Reorder requirement objects

In Word, generate a preview document for the requirement structure.

To move an object up one level higher in the structure, in the preview document Requirements
pane, right-click the requirement object that you want to move and choose Promote.

The requirement object is moved up one level in the structure.

To move an object down one level lower in the structure, in the preview document Requirements
pane, right-click the requirement object that you want to move, and then choose Demote.

The requirement object is moved down one level in the structure.

To move an object up one position in the structure within the same level, in the preview document
Requirements, right-click the requirement object, and then choose Move Up.
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The requirement object is moved up one position within the same level in the structure.

5. To move an object down one position in the structure within the same level, in the preview
document Requirements, right-click the requirement object that you want to move, and then
choose Move Down.

The requirement object is moved down one position within the same level in the structure.
Assign Teamcenter IDs to requirement objects
1. In Word, generate a preview document for the requirement structure.
2. Inthe preview document, select the requirement objects that you want to assign a Teamcenter ID.
3. Right-click and choose Assign Type.

4. Inthe Item ID box, type the ID or click Assign ID to automatically generate an ID from predefined
naming rules. If you selected multiple objects, you must click Assign ID because you cannot type
the ID.

A dialog appears with a progress bar indicating that Teamcenter is generating the new IDs. If you
only selected one object, the new ID is generated and displayed in the Item ID box. If you selected
multiple objects, the new IDs are generated, but no value appears in the Item ID box.

5. Click Apply.

The requirement objects are assigned the Teamcenter IDs.

Note:

If you do not assign a Teamcenter ID, the ID is automatically generated for the requirement
objects by the Teamcenter import process.

Change requirement object types
1. In Word, generate a preview document for the requirement structure.

2. Inthe preview document, select the requirement objects for which you want to change the object
type.

3. Right-click and choose Assign Type.

4. Inthe Assign Type dialog box, click # button in the Select Object Type box and choose the object
type for the selected requirement objects.

5.  Click Apply.
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The requirement objects are changed to the specified object type.
Save a preview document
1. In Word, generate a preview document for the requirement structure.
2. Inthe preview document, choose File->Save As.
3. Inthe Save As dialog box, type the name for the preview document in the File Name box.
4. Click Save.

The preview document is saved to disk.

Note:

To commit the changes to Teamcenter, you must import the preview document to
Teamcenter.

Importing object data from Microsoft Office Excel

Excel import process overview

Client for Office works through Microsoft Office Excel for exchanging Teamcenter structures such as
requirement specifications, functional models, logical models, and product structure assemblies.

For example, your project may employ an outside contractor to design a logical model of an
implementation solution. To submit that architecture for approval or modification, the contractor can
define its structure in Excel and send the file to you for potential import to Teamcenter.

By importing the Excel data, you can create or modify the structure in Teamcenter.
* If the structure does not exist in Teamcenter, it is created from the Excel data.
Only imprecise assemblies can be created for a product structure.
* If the structure exists in Teamcenter, the Teamcenter structure is updated from the Excel data:
* New objects and properties in the Excel data are added to the structure.
* Changes in the Excel data are applied to the latest working revisions of the corresponding objects.

* Existing objects and property values not represented in the Excel data are removed from the
structure. Removed objects remain in Teamcenter.
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Caution:

When you perform an Excel import, runtime properties are not updated. Only persistent properties
are updated or set during an Excel import.

Caution:

Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates an
error message.

Note:

* Only imprecise structures can be imported.
* Absolute occurrences and incremental changes are not supported.

* The import process does not configure structures in Teamcenter, for example, by defining
revision rules. Only the latest working revisions are updated.

* The Excel import feature is available only for the four-tier Teamcenter rich client.

Client for Office includes a wizard that guides you through the import process. You begin by opening
the Excel file that contains the data to import. Then, you click the Import to Teamcenter button on the
Teamcenter ribbon to start the wizard.

Preparing data to import from Excel
There are two ways to obtain data for the Excel import process:
* Generate offline Excel file that combines object data and control instructions.

You can generate an offline file when you export data from the Teamcenter rich client to Excel. The
data and the control instructions are inserted on separate sheets. You can add, modify, and delete
data before the import.

* Build Excel input files manually, defining the data in one file and control instructions in a separate file.

You can also use input files that you receive from an external source, such as a design contractor who
does not have Teamcenter.
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Caution:

To define control instructions manually, you must understand the data in each data file column
and the way in which the data relates to the Teamcenter schema. Siemens Digital Industries
Software recommends that control files be defined only by Teamcenter administrators.

You must associate the data file with the correct control file during the import procedure. If you have
questions about the correct control file for your data, consult your Teamcenter administrator.

Working in offline Excel import files

Data and control information can be combined in a single Excel file. You can create this file when you
export data from the Teamcenter rich client to Excel.

In the Export to Excel dialog box, choose the Work Offline and Import option to generate a
preconfigured file automatically.

* The data conforms with the mapping information because Teamcenter outputs them both from the
same context.

* The data and the mapping information are inserted on separate sheets.
* The data can be imported without associating a separate control file.

You can save the offline file locally, and edit the data to modify the corresponding structure in
Teamcenter. Changes are applied in Teamcenter when the import process is complete.

Caution:

» Before importing edited data, you must also edit the control sheet to conform with the data
sheet.

* The Multi choice property is not supported with Excel import using the Work offline and
import option.

* Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates
an error message.

* Excel import does not support string array LOV properties. Single choice LOV is supported but
this list of values is not displayed. You must fill in the values in Excel and then import the Excel
file.
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Generate an offline Excel file
You can export Teamcenter objects to an Excel file that is preconfigured for the Excel import process.

In the Teamcenter Export to Excel dialog box, select the Work Offline and Import option to generate
an output file that you can save outside of Teamcenter. You can then edit the data in the output file
offline, and use the file at a later time to import object data from Excel. Your edits are applied in
Teamcenter when the import is complete.

Caution:

* Only items, item revisions, and their subtypes can be imported from offline Excel files. However,
it is possible to export objects of other types from Teamcenter.

Before you start the export process, ensure that you do not select objects based on types other
than Item and Item Revision. Otherwise, attempts to import such offline data fail without
notification.

* Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates
an error message.

1.  Select the top-level object in a structure and then choose Tools=>Export->Objects to Excel.

ﬁ:ﬂ 000024-Physical Robot Requirements 000143-Robot Function X 1 =
Function Rev Name Item Type Trace Link | Motes | Connected ..
B--»_ﬁ:j 000143/4:1-Robot Function (View) Rebot Function Function
-7 000225/A:1-5ensor Sensor PSConnection W1
< 000238/ A:1-Control Flow Control Flow PSConnection W1,
= nfj 000145/A1-Manage Sensors (View) Manage Sensors Function
s Metwork_Port
g 000243/A:1-Sense End Sense End PSConnection W1,
7 000244/81-Move position Move position PSConnection W11
e 000245/4:1-Over Current Over Current PSConnection W01
gt 000246/ 4:1-Movement Movement PSConnection |
-agr 000247/41-Commands Commands PSConnection W1
=) {ﬁij' (000153/4;1-Sense Movement (View) Sense Movement Function
:I""F:j (000158/4:1-5ense End Stop (View) Sense End Stop Function
]-»_ﬁ:j’ 000160/4;1-5ense Obstacle (View) Sense Obstacle Function
:I-{.P:j (000156/4;1-Sense Arm Positions (View) Sense Arm Positions  Function
=) {ﬁij' 000157 /4;1-Sense Over Current (View) Sense Over Current  Function
»ﬁfj 000310/4:1-5ense Gripper Position Sense Gripper Positi.. Function
»ﬁ:j 000311/4:1-5ense Temperature Sense Temperature  Function Oy
[ ﬁfj’ 000161/A:1-Manage Communications (View) Manage Communic... Function
[E .ﬂ:j' 000144741 -Control (View) Control Function
nfj 000309/A1-Manage 10 Manage 10 Function

2. Inthe Export to Excel dialog box, select Work Offline and Import.
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Output

& Export To Excel

() Static Snapshot

Qutput Template

@ Use Excel Template

@ Work Offline and Import

Check out ohjects before export

(©) Export All Visible Columns

() Live integration with Excel (Interactive)

() Live integration with Excel (Bulk Mode)

|IREQ_default_struct_template

Copy URL] |

(©) Column Configurations

OK

)|

Cancel ]

3.  Under Output Template, select Use Excel Template, and then select the export template from the

list.

4. Click OK.

Teamcenter configures the Excel output file with two worksheets.

* Sheet1 contains the property data that is specified by the export template.

[ilzTsTals] A B C D E F G
1 [Siemens |IPLM Software
2 Teamcenter Excel Export
3 | “Live” edit on this spreadsheet requires Teamcenter Extensions for Microsoft Office
4
5 Type Name 1D Description Scalar Type RELATION Relation Identifier
= Function
6 Revision Robot Function  [000143 FunctionalityRevision
PSConnection
7 Revision Sensar 000225 PSConnectionRevision |PSOccurrence_struct |40
PSConnection
8 Rewvision Contral Flow 000238 PSConnectionRevision |PSOccurrence_struct |60
Function
9 Revision Manage Sensors (000145 FunctionalityRevision  |PSOccurrence_struct |20
PSConnection
10 Revision Sense End 000243 PSConnectionRevision |PSOccurrence_struct |90
PSConnection
11 Revision Move position 000244 PSConnectionRevision [PSOccurrence_struct  [100
PSConnection
12 Rewision Ower Current 000245 PSConnectionRevision |PSOccurrence_struct [110
4 4 » M| Sheetl  Sheetl-ControfFile . %3 4] [T

* Sheet1-ControlFile contains instructions for processing the property data.
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[ A B

c D E F G
1 IIgnored Active Active Active Active Active Active
2 ObjectAttribute  |ObjectName |ObjectlD ObjectAttribute | ObjectType RelationshipType RelationshipAttribute
3 |object type object_name object_desc Fnd0LogicalBlockRevision  |FND Tracelink name
4 | object_type object_name object_desc FunctionalityRevision PSOccurrence_struct |seq_no
5 |object_type object_name object_desc ltemRevision FND TraceLink name
6 |object_type object_name object_desc PSConnectionRevision PS0Occurrence_struct |seq_no
7
8
9
10
11
12
13
14
15
16
17
18
19
20
4« W sheetl | Sheetl-Controlfile /¥ gl

Note:

The output file contents vary according to the type of structure and the export template that
you select. For a wider sample, experiment with other structures and different templates.

Understanding the contents of a data sheet

In the Export to Excel dialog box, the Work Offline and Import option generates structure data in a
spreadsheet that is automatically configured for importing.

* The rows represent the objects in a structure hierarchy such as functions or logical blocks in a design
model, including interfaces, connections, and relationships among objects.

* The columns contain the Teamcenter properties that are specified by the selected export template,
and the property values for each object in the structure rows. For example:

* Object types, object names, and object identifiers.
* PSOccurrence relationships and Generic Relation Management (GRM) rules.

* Relationship properties such as reference designators, budget values, and quantities.
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[ [z]z]+]s]] A | B [# D E F G
1 [Siemens PLM Software
2 Teamcenter Excel Export
3 “Lwve” edit on this spreadsheet requnes Teamcenter Exfensions for Mcrosofl Office
5'#!!@ I} Desciiption __ ScalarType _ RFUATION _____ Relarion idenifinr |
& |Revision Ribot Function (000143 FunctionalityRevision
) FSCeanection
T |Redsian Senzar Qan2as PECannectionRedsion |[PES0ecurrance stuet (40
. PSConnection
B |Revisian Contral Flaw nan23a PECaonnectionRevision |PS0ccurrance stuct (B0
Function
4 |Revision |Manags Sansors (000145 FunctionalityRevision  |PSCccurrence struct |20
: PSConnection
10 |Revision Sense End Qo243 PEComnectionRevision |PSCccumence_stouct  [50
PSConneclion
11 JResngian Ao posian (000242 PECannectiocnRension |PSOccurrence stouct | 100
FSConnaction I
12 isi Crsar Currant 000245 PEConnectionRevision |PSCccurrance_stnuct (110

4 b M| Sheotl . Sheetl-Contrabde . o2 NEN

1 Structure objects
2 Object properties
3 Excel Outline features
Tip:
To hide an object’s children, click the minus sign (-) for that object. Click the plus sign (+)
to show the children.
Caution:

Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates an
error message.

Default columns for offline Excel files

By default, Teamcenter inserts three different property columns in every output file exported with the
Work Offline and Import option in the Export to Excel dialog box.

Warning:

Do not delete any of the default columns. If the data sheet does not contain all of the default
columns, import processing stops and the entire transaction is rolled back.

Note:

* The default columns are inserted whether or not they are specified in the Excel template that
you select for the export.

4-24



Control sheet contents and import processing _

* You can rename the default columns using any names you want. |

Column name Description
Object ID Teamcenter object identifier for the corresponding structure element.
Note:

When editing the data, you can automatically populate empty cells
with the next available identifiers from Teamcenter.

1. On the Excel ribbon's Teamcenter tab, click the text portion of
the Import to Teamcenter button.

2. Inthe list, select Assign Teamcenter IDs.

Empty cells for folder identifiers cannot be populated automatically.

Object Type Teamcenter object type for the corresponding structure element.

Note:

Cells in this column contain the exact names of the object types in
the Teamcenter schema.

Object Name Name of the corresponding element in the Teamcenter structure.

Control sheet contents and import processing

A control sheet is a table of instructions that govern the Excel import process. Its columns map the data
sheet objects to Teamcenter schema elements such as object types, relationship types, and object and
relationship properties.

Caution:

Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates an
error message.

The processing instructions consist of keywords, keyword tags, and tag values. The import process uses
this information to build a temporary structure in memory
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A I =1 el 0 E E
1

3ri e T Iati ipType
object_desc FrollogcalBlockRewsion  |FND_Tracelink

objact_desc [FunctionalityRevision |PSCccurrance_stuct [seq_no
FHNC Tracelink
PS0coumance_stuct |seq no

| 3 [T
| 4 |object_type objact_nams

| 5 Jobject type chject_name
| 6 |object_type ohject_name

| 14
|18
|16
|17
|18
|19
| 20

BermBensian
P SConnectionRevision

o Fa|=| S| @ = =

[ A4 ¥ ¥ sheett | sheeti-Controlfile T L]
1 Keywords
2 Keyword tags
3 Keyword tag values

1. Keywords specify which data sheet columns are parsed into the temporary structure, and which are
excluded from processing.

Keyword Description

Ignored The column is excluded from processing.

Active Individual cell values map to the corresponding structure
objects.

2. Immediately below a keyword, the keyword tag associates that column with a Teamcenter schema
element (object property or attribute).

3. Thecellsin the keyword tag column include the keyword tag values (schema names) potentially
associated with the Teamcenter schema element (keyword tag).

Keyword tag Tag value

ObjectName Schema name of the object name property.

ObjectID Blank. Teamcenter assigns object identifiers and populates this
column automatically.

ObjectAttribute Schema name of the property in the related data sheet
column.

ObjectType Schema name of the object type.
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Keyword tag Tag value

RelationshipType Schema name of the relation type.

RelationshipAttribute Schema name of the property in the related data sheet

column.

Working with Multi Field Key (MFK) objects

Note the following when using Teamcenter Excel import for Multi Field Key (MFK) objects, such as an
MFK requirement:

To create a new MFK type of object, fill in all the mandatory MFK properties in the Sheet 1 sheet in
the Excel file. Mandatory properties are marked with an asterisk in the Sheet1-ControlFile sheet. For
example, note that in the Sheet1-ControlFile sheet, pv2_MFK_strkey1, which is a mandatory MFK
property name, is written as pv2_MFK_strkey1* as ObjectAttribute.

H ©- s PRT900846 xlsm - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
H5 - fr || Pv2_MFK_Require
A B c D E F G
1 lgnored Active Active  |Active Active Active Active
2 |ObjectAttribute  |ObjectName |ObjectlD |ObjectAttribute  |ObjectAttribute ObjectAttribute DbjectAttribute
3 |object_type object_name object_desc pv2_MFK_strkey2® |pv2 MFK_strkey1*|object_name®
4 |object_type object_name object_desc pv2 MFK_strkey2® |pv2 MFK_strkey1*|object_name®
5 [object type object_name object_desc pv2 MFK_strkey2* |pv2 MFK_strkey1*|object_name®
6
7
Sheetl | Sheetl-ControlFile ®

For updating an MFK object, ensure that you add all the MFK property values in the Sheet 1 tab. If

you have not provided all values that are mandatory for the MFK object, a Multiple object found

error is displayed because the software is not able to uniquely identify the object.

To identify the mandatory properties of an object, see the fields marked with an asterisk in the

respective Create object dialog box.

Excel import validation tests

When you initiate the import process, it parses the Excel data into an intermediate structure in memory.
Then, it runs a series of tests against that structure.

Test

Control sheet validation

Description

Checks the context tags and the rule table against the Teamcenter schema.

* If the control sheet does not match the schema, cancel the process,

correct the sheet, and re-initiate the process.
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Test Description
* If the information matches, you can continue the import.

Column mapping Tracks the validated rule table information to the data sheet columns and
verification displays that mapping for your verification.

You can continue with the displayed mapping. Or, cancel the process, make
corrections, and re-initiate the process.

Data error detection Examines each data sheet cell value for compliance with the format of the
related property type.

* If any value does not conform, processing stops and the entire transaction
is rolled back.

Correct the data sheet and re-initiate the process.

e If all values conform, the data is committed to Teamcenter.

Caution:

The Outline features must be enabled on Excel's Data tab.

Editing offline Excel files for modifications in Teamcenter

Updates for Teamcenter structures and objects

Edits you make in an offline Excel file result in updates to the Teamcenter structure and object data when
the Excel import process is complete. You must also edit the control sheet to conform with the data
sheet.

Caution:

Only items, item revisions, and their subtypes can be imported from offline Excel files. Ensure that
the file does not contain objects based on types other than Item and Item Revision. Otherwise,
attempts to import such objects fail without notification.

* Create and remove objects in the target structure.

Tip:

You can show and hide structure levels by clicking Excel's numbered outline symbols or the plus
signs (+) and minus signs (-).
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1234] A

Siemens

Teamcenter
Live™ edi onthis 5

o k=

Type

= & Reguirement

7 Reqguirement

| |_ - 9 Reguirement

» Create, modify, and remove object properties in the target structure.

Caution:

Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates
an error message.

Create an object in the target structure

For each object that you create in a structure, Teamcenter generates an item first, and then an item
revision. You must add a row for the base item type in both the data sheet and control sheet.
Caution:

Only items, item revisions, and their subtypes can be imported from offline Excel files. Attempts to
import other object types fail without notification.

1. Inthe Excel data sheet, insert a new row at the level and position where you want to create the
object in Teamcenter.

[TzlzTe]sTe]] 4] A [ B [ ¢ ] D [ £ [ 3 | G |
4 Type Name 1D Description Scalar Type RELATION Relation Identifier
(=] Funiction Yehicle
6 Revision Functional Model 020271 FunctionalityRevision
= Function
7 Revision Closures 030272 FunctionalityRevision  [PSOccurrence_struct |10
Function
8 Revision Tailgate 030273 FunctionalityRevision  [PSOccurrence_struct |10
Provide Easy
Function Access to Rear
9 Revision of Yehicle 090274 FunctionalityRevision  |PSOccurrence struct |20
10 [
Secure Access | M
Function to Rear of
11 Revision Yehicle 030275 FunctionalityRevision  [PSOccurrence_struct |30
haintain
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2.

3.

4.

Enter the object's property values in the new row.

Caution:

The Scalar Type cell must contain the value for the base item type. The base type is required
because Teamcenter generates the persistent item before adding the occurrence in the
structure.

1|z [3]4]s]s A, B C o] E F G
1 | Siemens PLM Software
2 |Teamcenter Excel Export
3 "Live" edit on this spreadsheet requires Teamcenter Extensions for Microsoft Office
4
5 Type Name 1D Description Scalar Type RELATION Relation Identifier
[=] Function “ehicle
6 Revision Functional Model 020271 FunctionalityRevision
Function
=] 7 Revision Closures 030272 FunctionalityRevision  [PSOccurrence_struct |10
Function
=] g | Revigion Tailgate 090273 FunctionalityRevision |PSOccurrence_struct |10
Provide Easy
Function Access to Rear
S Bevizion of Wehicle Qo074 EunctionalityBevision (BS0courrence struct 120
Pravide
Function Adeqguate
10 | Revision Lighting 090297 Functionality P=0ccurrence struct |20
TECUTE ACCESS —
Function to Rear af
11 Revision Yehicle 030275 FunctionalityRevision  [PSOccurrence_struct |30
haintain

In the Excel control sheet, copy the row containing the keyword tag values, and insert it above the

selection.
| arial A v AT AT % v % s 8] E F G
B J = P Active Active Active Active
e - '..0.0._')',0__,__..D OhjectAttribute ObjectType RelationshipType RelationshipAttribute
bnhiart tuna [nhiart narma | ohject desc FunctionalityRevision PS0ccurrence struct |seq no
4 Cut
Copy

.- iy,

Paste Options:
3| [123] [ £ [28] %] [==

Paste Special.. | r

N PN P [N

Insert Copied Cells
Delete I:%

In the new row under the ObjectType keyword tag, enter the value for the base item type.

A, B C 8] E F G
1 lgnored Active Active Active Active Active Active
- - 0k OhieclC - - octTyne Balati il Relal - - .
3 |object type ohject_name ohject_desc [Functionality PS0ccurrence_struct |seg no
4 Tobject_type object_name object_desc [FunctionalityRevision PSOccurrence_struct [seq_no

An object occurrence is added to the structure when the import process is complete. The underlying
item and item revision are created in Teamcenter.
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Create a property in the target structure

Caution:

Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates an
error message.

1. Inthe Excel data sheet, insert a column to the right of the right-most column.
2. Enter the property name in the new column's top cell.
3. Inthe cells below the top cell, enter the property values for the objects.

The values for existing properties are applied to each object in the structure when the import process is
complete.

Modify object properties in the target structure

Caution:

Properties with dynamic and cascading lists of values (LOVs) cannot be modified in the target
structure. If the Excel input file contains these LOV property types, the validation test generates an
error message.

* In the Excel data sheet, enter or overwrite the desired cell values in the object’s property columns.
The new values are applied in Teamcenter when the import process is complete.
Remove an object from the target structure

* Delete the corresponding row in the Excel data sheet.

Warning:

* Do not delete the row for the only child of a given parent in both Teamcenter and Excel. Instead,
add the _remove suffix in the cell for the child object identifier.

* Do not add the _remove suffix for an object that has a sibling at the same level.

The object occurrence is removed from the structure when the import process is complete.

Note:

The underlying item and item revision remain in Teamcenter.
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Remove a property from the target structure

* Delete the corresponding column in the Excel data sheet.

Warning:

Do not delete the Object ID, Object Type, or Object Name column. Teamcenter inserts these
columns in the output file by default.

If the data sheet does not contain all of the default columns, import processing stops and the
entire transaction is rolled back. You can rename the default columns using any names you want.

The property is removed from each object in the structure when the import process is complete.

Working around Excel's eight-level limitation

Excel's outline hierarchy is limited to eight levels. When the selected Teamcenter hierarchy exceeds that
limit, all objects are exported to an unstructured file. Excel's Outline features are disabled in this file.

Data cannot be imported if the Outline features are disabled on Excel's Data tab.

To work around this limitation, you can:

* Export the structure to a standard Excel file by selecting Static Snapshot in the Export to Excel dialog
box.

* Edit the static output file to match the object and relationship hierarchy in the structure.

* Initiate the import process from the edited static file.

Note:

Associate the disabled output file’s control sheet with the edited static file.

Initiate the import process

1. With the data sheet active in the Excel import file, click the Import to Teamcenter button on the
Teamcenter tab.

Control sheet validation begins against the intermediate structure.

Tip:

You can automatically fill in empty object identifiers by clicking the lower half of the button
and clicking Assign Teamcenter IDs.
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Note:

* Identifier cells for folders cannot be populated automatically.

* If the Teamcenter Login page is displayed, enter your Teamcenter user identifier and
password, and then click Login.

Do one of the following:

If you see Do this

A message * Click OK.

stating that

parsing is Column mapping verification begins against the intermediate structure.
complete The Column Mappings dialog box displays the current mapping between

the data sheet and the control sheet. Review this summary to determine if
the mapping is correct.

* The process cannot continue if the dialog box does not display at least
one second-level node below any top-level node.

* The process can continue if control sheet columns map to data sheet
columns other than the ones that you intend.

To stop the process and correct the mapping, click Correct Data.
You must re-initiate the process after making the corrections.

To continue the process with the current mapping, click Continue.
Error detection begins against the intermediate structure.

* If the Validation Errors dialog box opens, Correct the data sheet
errors, and then re-initiate the import process.

* |f the Excel Import wizard opens, follow the instructions on the wizard
tabs until the Step Four tab states that the process is complete.

Tip:

To work with the imported structure in the Teamcenter rich client:

a. Use the search feature to find the structure's top-level object.
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If you see Do this

b.  Select the top-level object and send it to the desired
application.

The Control File a. Record the dialog box contents (for example, in a screen shot) for
Validation dialog reference during corrections.
box

b.  Click Cancel to terminate the process.

c. Inthe control sheet, correct the items listed in the dialog box.

d. Re-initiate the import process.

Correct data sheet errors

Note:

The Excel Import wizard is displayed if no data sheet errors are detected.

When the data sheet contains errors, the Validation Errors dialog box is displayed.

EH Validation Exrrors

Excel BOM import plug-in encountered following errars while parsing Excel
data. Import process will not start unless these errors are corrected. You can
click on Row number to navigate to the incorrect data in Excel.

Yalidation Error[E44] - Ohject type information is absent. Enter object type to generate [D

d | i
Flease correctthe Excel data where ever required. el
The import process needs to be restarted after
corrections.

1. Record the dialog box contents (for example, in a screen shot) for reference during corrections.
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2. Click Cancel to terminate the process.
3. Correct the items listed in the dialog box.

4. Re-initiate the import process.

Step One: Processing options

o= Excel Import Wizard =] ® =]

Step Cne | Step Two I Step Three I Step Four

Specify optionsforimport
Override behavior

[ Create new revision

Number of validation errors allowed: |50 =

o

On the Excel Import wizard, the Step One tab contains the following processing options.

Option Description

Create new revision Specifies whether to create new revisions when structure objects are
updated, added, or removed.

* Select the check box to create new revisions.

¢ Clear the check box to overwrite the latest revisions.

Note:

The createNewRevision custom preference determines the check
box default state.

* The check box is selected if the preference value is true.
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Option

Number of validation
errors allowed

Logging Method

Description

* The check box is cleared if the preference value is false or if the
preference is not present on the Teamcenter server.

If you have questions about preferences, consult your Teamcenter
administrator.

Sets the maximum number of rows for data error detection.

The default value is 50.

Sets the log file granularity for process diagnostics.

* Select Normal for basic information about exceptions other than
feedback from the server.

* Select Verbose for basic exceptions and details of errors such as
failures and performance bottlenecks.

You can view the log file for general information and to research errors.

Step Four: Message handling

While the Step 4 tab indicates progress, it can display any or all of these messages:

Message

Some obj ects being
i mported are
currently checked
out .

Some obj ects

bei ng i nported
were nodified in
Teantenter after
this sheet was
exported.

Action

Click Yes to continue the process without overwriting the objects with
data from the import file.

Click No to stop the process and check in objects.
Caution:

If you click No, you must re-initiate the process.

In the import file, a list of the checked out objects and their reserving
users is inserted on a separate sheet.

Click Yes to continue the process and overwrite the objects with data
from the import file.

Click No to stop the process and identify the objects.
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Message Action

Caution:

If you click No, you must re-initiate the process.

In the import file, the objects that were modified in Teamcenter are
highlighted in red.

The text of sone * Click Yes to continue the process without overwriting Body Text
requi rements was property values in Teamcenter.
created in M5 Wrd

and may have rich * Click No to stop the process and identify the requirements.
cont ent.

Caution:

If you click No, you must re-initiate the process.

In the import file, the requirements with rich text content are
highlighted in orange.

Step Four: Feedback and diagnostics

o Excel Import Wizard o] =

Step One | Step Two | Step Three | Step Four

Excel BOM import feedback is provided as the last step in the process. Thefeedback is shown
in the text area. The feedback is dipboard enabled, which means text can be selected and
copied to other application fortaking a closer look into issues.

\/ Excel import process completed successfully. Save Repart ..
Comparing structures and Importing file. .. -

Done! |" |

TcXML Import Log File

Server Hostname @ SIEMENS-ADP3MB2

Sitename[Siteid] : Teamcenter 9.1 5E Training[-2076711384]

Teamcenter version : Teamcenter V9000.1.0.20120307.00

XML-FileName : C:\TempltransientVolume_infodba

\finalExportedTCXML _Excel 5004712c00000c4c0000 3d38. xml

Syslog-FileMame @ C:\Temp\tcserver. execdced3s.syslog o

Wiew DiagnosticLogs

When the Step 4 tab states that the import is complete, you can do the following:
* To write server feedback to a separate file, click Save Report.

You can use the standard Windows functions to copy the feedback from the text pane to another
application, for example, Microsoft Notepad.
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* To open the process log file, click the View Diagnostic Logs link.

The log file can contain basic information on exceptions and details on errors. Granularity is set by the
Logging Method option on the Step 1 tab.
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5. Conducting content reviews using Client
for Office

Overview of conducting content reviews

Content reviews are generally conducted by multiple individuals during a review cycle. Client for Office
enables you to add and review markup comments in Microsoft Office Word documents during content
reviews. Word documents are stored in Teamcenter and can be attached to items and used in workflows.

This functionality differs from adding markup comments to requirements objects using live Word as the
interface to the content of the requirement objects.

Client for Office provides markup features for all stages of a Word document review cycle. On the
Teamcenter tab of the Office ribbon, you click Markup [ to display the Teamcenter Markup Manager
pane. Depending on your role in the review cycle, you can use the Teamcenter Markup Manager pane
to perform review tasks such as:

Add and delete comments.

¢ View comments.

Modify comment text and comment types.

* Revise content according to reviewer comments.

Apply a disposition comment and a disposition status to the comment.

Client for Office markup features work with Word's built-in markup features, which are available on the
Review tab of the Office ribbon. The document displays comments according to your Tracking settings
on the Review tab.

Caution:

If your Teamcenter username or ID is the same as the username or ID of the operating system of
your computer, use the Teamcenter Markup panel to perform markups, instead of Microsoft Word
comments to prevent possible corruption of data.

Multiple Teamcenter users can mark up the same document concurrently.
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Caution:

Siemens Digital Industries Software recommends against setting document protection and editing
restrictions using the options in the Protect button group on the Word Review tab. Using these
settings has the following impact on the operation of the Load button:

* Word hides existing comments and they cannot be removed with the Load button.

* Word's hidden comments cause comment sequence numbers to be reset so that they do not
reflect the actual sequence in the document.

* The correct sequence numbers are restored when you close and reopen the document.

Stages and roles for conducting content reviews

Stages and roles in a review cycle

Each user who participates in a content review cycle has a role according to their responsibilities in the
content review cycle. Each role is involved in different stages of the review cycle.

Role Stage
Clear markup comments from a document
(optional).

Author
Add and edit review comments.

N

Reviewer

View the current markup comments in the
review document.

»

. ™
Author, reviewer,
or reader

Revise the content according to reviewer
markup and apply a disposition status to the
reviewer markup entries.

Author
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Role descriptions and permissions for a review cycle

Your role in the content review cycle determines the tasks you can perform and the functionality
available to you when working with the Teamcenter Markup Manager pane. Your role is defined by:

* The Teamcenter access privileges defined by the administrator.

Administrators use access control lists to set users' markup privileges on both document datasets and
datasets that store markups.

* How you open the document.

Depending on your access privileges, you could assume different roles for the same document. For
example, as a user with write privileges, you could perform author tasks or the reviewer tasks. In this
case, your role depends on how you open the document.

Role Description Access privileges How open Functions
document available
In the review cycle, an * Write and Open and Load and
author: Markup access for Check-Out Save/Extract
document datasets File
Author * Can clear markup
comments from a * Write access for
Creates and document. markup datasets
edits the
document * Can add, modify, and
content and .
remove review comments.
manages
review .
comments. e Can revise the d(?cument
according to reviewer
comments.
* Can apply a disposition
status to the reviewer
markup entries.
A In the review cycle, a * Read and Markup Open File Load and
reviewer: access for (Read Only) Save/Extract
PSS document datasets
Reviev:/er * Can adq revi'ew commgnts .
and edit their own review  * Write access for
Adds comments. their own markup
comments as datasets
amemberof . cannot modify comments
the review owned by other users.
team.
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Role Description Access privileges How open Functions
document available

¢ Cannot edit document
content.

In the review cycle, a reader: * Read access for Open File Load
document datasets (Read Only)

¢ Can view the document
contents and review * View access for
Reader comments. markup datasets

Reviews the
document for ¢ Cannot add comments.

informational
purposes. * Cannot modify comments
owned by other users.

¢ Cannot edit document
content.

Working in the Teamcenter Markup Manager pane

Teamcenter Markup Manager pane

From the Teamcenter tab, you use the Markup & button to display the Teamcenter Markup Manager
pane. Use this pane to perform tasks for a document in a review cycle.

Tearncenter Markup Manager X

[Luad] [Save!Extract] [Repnn] o

4 [J]All Users
4 [Jf] Teamcenter Users
de0s (deds)

Other Users o
= Arranged by: Order First on Top -
X del5 (del5) 3/6/2014 5:38:16 PM

This document currently has no markup. To create a new markup, select
+" the range o be commented, type comment here, then click the green
check icon. For context menu, right click in this pansl.

5-4



Using the markup buttons _

1 Pane buttons Use the Load, Save/Extract, and Report buttons to perform
Teamcenter markup actions.

2 Upper pane Contains a hierarchical tree of user categories and names, referred to
as the comment owners tree.

Below the root node, the secondary nodes represent categories of
users who own comments in the document.

Use the comment owners tree to identify the reviewers and their
comments as well as select which comments to show or hide.

3 Lower pane Displays review comments as items in a list, referred to as the
comment details list.

This list resembles the message layout in your Outlook Inbox.

Use the comment details list to manage review comments including
add, modify, view, and delete review comments.

Using the markup buttons

Use the buttons at the top of the Teamcenter Markup Manager pane to perform markup actions on the
open Word document and its associated Teamcenter markups.

Button Action

Load Removes any comments not yet saved and inserts comments from all Teamcenter
markups that are currently associated with the document.

Caution:

Siemens Digital Industries Software recommends against setting document
protection and editing restrictions using the options in the Protect button
group on the Word Review tab. Using these settings has the following
impact on the operation of the Load button:

* Word hides existing comments and they cannot be removed with the
Load button.

* Word's hidden comments cause comment sequence numbers to be reset
so that they do not reflect the actual sequence in the document.

* The correct sequence numbers are restored when the user closes and
reopens the document.

Save/Extract Depends on the role that the user assumes.
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Button Action

* For an author (who opens and checks out the file), clears new and modified
comments from the window and saves them as a markup object in Teamcenter.

* For a reviewer (who opens the file as read-only), saves new and modified
comments as a markup object in Teamcenter.

Note:

The Save/Extract button is unavailable for a reader.

Report Generate an XML list of the current markups and disposition status, and open
them in Microsoft Excel.

Note:

» Teamcenter markup objects are automatically associated with the document and the users who
own the comments.

* Markup objects cannot be displayed by expanding the source datasets in the Client for Office

Folder View.

Use the Teamcenter rich client to display markup objects.

Identify reviewers and their comments

4 [ Al Users
4 [ Teamcenter Users
d205 {deds)
Other Users

In the Teamcenter Markup Manager pane, the upper pane contains a hierarchical tree that consists of
the following:

* The root node, named All Users
* Asecondary node named Teamcenter Users

At the next lower level, a node is shown for each Teamcenter user who added markup comments
using Teamcenter Markup Manager.
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Show or hide reviewer comments _

Note:

The user's Teamcenter identifier is shown in parentheses (()) to the right of the name.

* Asecondary node named Other Users

At the next lower level, a node is shown for each external user who owns comments that were
inserted through the standard Word markup features.

Note:

The user's initials are shown in brackets ([ ]) to the right of the name.

You can expand and collapse the nodes and use the checkboxes to hide and show comments in the
lower pane and in the review document.

Show or hide reviewer comments

* In the upper pane of the Teamcenter Markup Manager, in the hierarchical user tree, do one or both
of the following:

* Clear the check box for each user whose comments you want to hide.

Tip:

You can clear the check box for the root node or a secondary node to clear all lower level
check boxes simultaneously.

The comments are hidden in the details list and in the document.

* Select the check box for each user whose comments you want to show.

Tip:

You can select the check box for the root node or a secondary node to select all lower level
check boxes simultaneously.

The comments are displayed in the lower pane of the Teamcenter Markup Manager, and in the
review document.

Note:

A solidly filled check box indicates a mixture of selected and cleared check boxes below that
node.
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Manage review comments in the comment details list

In the Teamcenter Markup Manager pane, the lower pane displays review comments as line items in
a list and is referred to as the comment details list. Each item in the list contains markup details for one
comment:

A graphic symbol that indicates the comment type

The owning user's name and user identifier

The comment text

The date and time of the most recent user action

= Armanged by: Order First on Top -

de05 (de05) 32172014 10:28:00 PM
‘., This part is obsolete.

de0s (delb) 872172014 10:27:00 PM
‘x_._f The indicator should blink.

You can arrange comments in the list and navigate from the list to comments in the document.

Use the comment details list to perform many of the tasks in the review cycle including:

Add review comments

Modify review comments

Modify comment types

* View comments

Delete comments

Comment types and symbols

The comment details list displays graphic symbols that indicate comment types. The symbol for each
comment appears in the leftmost position in the line.
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Symbol Description

L Indicates General comments in documents where you have Read/Write access.

General comments are used informally, for example, one user's questions on selected
content and another user's answers.

Note:

You can delete General comments before the document's release.

&d Indicates General comments in documents where you have Read-only access.

Note:

You cannot modify or delete General comments with this symbol.

= Indicates Hidden comments that are visible only to you as the comment owner.

Arranging comments in the details list

Buttons at the top of the comment details list control the comment text line display and the comment
sorting sequence.

Button Description

Show comment Switches the text line display between:
in single/multiple

lines * All text lines of each comment.

* Only the first text line of each comment.

The single-line display saves space when the details list contains a large
number of comments.

Note:

The line length depends on the width of the Teamcenter Markup
Manager pane.

Arranged by Displays a menu from which you can choose the sort key.

When you choose a sort key from the Arranged by menu, the details list immediately sorts the
comments. Your sort key choice appears in the button label.
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Arranged by menu
sort key

Order

Name

User ID

Date

Comment

Description

Sorts by the comment sequence numbers that Word generates in the
document.

The button to the right determines which comment moves to the top of the list.

First on Top The top comment is the one with the first sequence
number in the document.

Last on Top The top comment is the one with the last sequence
number in the document.

Sorts in alphabetical order of the owning user names.

The button to the right determines which comment moves to the top of the list.

A on Top The top comment is the one whose owning user name
is first in alphabetical order.

Z on Top The top comment is the one whose owning user name
is last in alphabetical order.

Sorts in alphabetical order of the owning user identifiers.

The button to the right determines which comment moves to the top of the list.

A on Top The top comment is the one whose owning user
identifier is first in alphabetical order.

Z on Top The top comment is the one whose owning user
identifier is last in alphabetical order.

Sorts by the modification date and timestamps.

The button to the right determines which comment moves to the top of the list.

Latest on Top The top comment is the one whose date and
timestamp is the most recent.

Oldest on Top The top comment is the one whose date and
timestamp is the earliest.

Sorts in alphabetical order of comment text.

The button to the right determines which comment moves to the top of the list.
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Arranged by menu

sort key Description
A on Top The top comment is the one whose text is first in
alphabetical order.
Z on Top The top comment is the one whose text is last in
alphabetical order.
Type Sorts by the General and Hidden comment types.

The button to the right determines which comment moves to the top of the list.

Hidden on Bottom The top comment is the General comment with the
most recent date and timestamp.

After the last General comment in the sequence, the
first Hidden comment is the one with the most recent
date and timestamp.

Hidden on Top The top comment is the Hidden comment with the
most recent date and timestamp.

After the last Hidden comment in the sequence, the
first General comment is the one with the most recent
date and timestamp.

Navigating to comments in the document

When you select a markup item in the comment details list, Client for Office locates the corresponding
comment in the document.

For example:

* To find the most recent comment, you can choose Arranged by—Date, click Latest on Top, and then
click the first item.

The comment and content selection are highlighted in the document, with the cursor at the end of
the last paragraph in the comment text.

Note:

The document displays Teamcenter Markup Manager comments according to your Tracking
settings on the Word Review tab.
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Capture legacy Microsoft Word comments as Teamcenter markup

If a Microsoft Word file has comments that are not saved as Teamcenter markups, you can save the
comments as Teamcenter markups. Note, however, that comments saved as Teamcenter markups are
saved as plain text. Any formatting or font changes are lost.

Note:

Siemens Digital Industries Software recommends using the Teamcenter Markup Manager to
manage comments.

1. In Teamcenter, create a Word dataset with the Word file that contains the comments.
2. Open Microsoft Office Word.
3. On the Teamcenter tab of the ribbon, click Open [¢7.
The Teamcenter Login dialog box appears.
4. Log on to Teamcenter.
5. In the Teamcenter Open dialog box:
a. Use tree in the Home pane to navigate to and select the document.
b.  Click the down arrow on the Open button and choose Open and Check-Out File from the list.

6. On the Teamcenter tab of the Office ribbon, click Markup [Z to display the Teamcenter Markup
Manager pane.

The comment details list shows no markup comments.
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Capture legacy Microsoft Word comments as Teamcenter markup _

Tearncenter barkup bManager * X

[Luad] [SavefExtract] [Repurt]

4 [J] Al Users
4 [f] Teamcenter Users
Tim Brown (timb)

Other Users
= Arranged by: Order First on Top -
¥ Tim Brown (timb) /62014 5:38:16 PM

This document currently has no markup. To create a mew markup, select
«" the range to be commented, type comment here, then click the green
check icon. For context menu, right click in this panel.

Click Save/Extract at the top of the Teamcenter Markup Manager pane.
The system extracts all the legacy Word comments and saves them as Teamcenter markups.
Click Save [} to save any changes you made to the document.

When a message appears asking you if you want to check in the document to Teamcenter, click
Yes.

Close the document.
To see the legacy comments in the document:

a.  On the Teamcenter tab of the ribbon, click Open [} to display the Teamcenter Open dialog
box.

b.  Use the tree in the Home pane to navigate to and select the document.
c.  Click the down arrow on the Open button and choose Open Read-Only from the list.

d.  On the Teamcenter tab of the Office ribbon, click Markup 5> to display the Teamcenter
Markup Manager pane.

The legacy Word comments appear, and the user is listed under Other Users.
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Tearncenter barkup bManager * X

[Lnad] [SaveIExtract] [Repurt]

4 [J] Al Users
4 [f] Teamcenter Users
Tim Brown (timb)
Other Users
de05 (dels)

= Arranged by: Order First on Top -
¥ Tim Brown (timb) 37672014 5:38:16 PM
v

de05 (del5) 0/5/2013 2:50:00 PM

., Color should be red.

In Teamcenter, any native Word markups you extract appear with the extracted suffix on the name
of the markup. Markups by Teamcenter users appear with their user names as the suffix.

a W) Requirernents for Rabot 3B
%= R3B_requirements docx.extracted
% R3E_requirements. docxtimb

Perform the tasks in a review cycle

Open Client for Office for content reviews

Client for Office is the connection between Teamcenter and Microsoft Office Word that enables you to
add and review markup comments in documents during content reviews.

The content review tasks that you can perform depend on your role in the review cycle.
1. Open Microsoft Office Word.

2. Choose the option from the Teamcenter tab of the Office ribbon for the action you want to take,
such as Open [¢.

The Teamcenter Login dialog box appears.
3. Log on to Teamcenter.

Client for Office is available for you to use for performing content review tasks in the review cycle.
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Clear markup comments from a document

As an author, that is, a user with write access who opens and checks out a document, you can clear
markup comments from a document. This is useful for sending the document through a review cycle
without showing any existing markup comments, for example, through email to non-Teamcenter users.
This does not remove the markup comments from the Teamcenter database. This is an optional step in
the review cycle.

1. In Client for Office, open the document in the author role by doing one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open and
Check-Out File.

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use tree in the Home pane to navigate to and select the document.

b.  Click the down arrow on the Open button and choose Open and Check-Out File from the
list.

2. Onthe Teamcenter tab of the Office ribbon, click Markup [Z to display the Teamcenter Markup
Manager pane.

3. Click Save/Extract at the top of the Teamcenter Markup Manager pane.
The comments are cleared from the document.
4. Click Save to save any changes you made to the document.

5. When a message appears asking you if you want to check in the document to Teamcenter, click
Yes.

6. Close the document.
Working with review comments

Add a comment

To add comments to a document during the review cycle, both authors and reviewers open the
document in the reviewer role. This is recommended, because in the reviewer role, you can use the
Load button to load any other reviewers' comments that were added since you opened the document. If
you open the document in the author role, the Load button clears all comments from the document and
other reviewers cannot see them.

If you use the Load button, you should use Save/Extract before closing the document, because content
may have changed causing the location of the markups to change.
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Readers cannot add comments.
1. In Client for Office, open the document in the reviewer role by doing one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open File
(Read-Only).

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use the tree in the Home pane to navigate to and select the document.
b.  Click the down arrow on the Open button and choose Open Read-Only from the list.

2. On the Teamcenter tab of the Office ribbon, click Markup to display the Teamcenter Markup
Manager pane.

3. Inthe document, select the text or graphic to associate with the comment.
4. Right-click anywhere in the details list, and then choose Create new markup.
A blank text box appears for you to enter the comment.
5. Click in the text box and enter the comment text.
You can enter multiple lines of text by pressing Enter to start each new line.
6. To add the comment to the document, click ] next to the text box.
To cancel the new comment, click (x) next to the text box.

When you add the new comment, it is added to the details list with the default comment type,
General, and the related symbol appears at the left.

7.  Click Save/Extract in the Teamcenter Markup Manager pane.

The markup comments are saved to Teamcenter.

Note:

Although the markups are displayed in the document, the Teamcenter Markup Manager
pane does not show the markups immediately after you click Save/Extract. To see these
markups in the Teamcenter Markup Manager pane, close the document, reopen it, and click
the Markups button in the Teamcenter tab of the Office ribbon.
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Note:

If multiple users are marking up the same document concurrently and an error message
appears indicating the base dataset is checked out by another user or is out of date, contact
your administrator to review the ITEM_relation_types_update_Imd preference.

8. Close the document.

9. If a message appears asking you if you want to save changes to the document, do one of the
following:

* To save a copy of the document to your local drive for your personal use, click Yes, and choose
the location where you want to save it.

Since the document is opened as read-only, you cannot save the document to Teamcenter.
* To close the document without saving a personal copy, click No.
View comments
Markup comments can be viewed by readers, reviewers, and authors.
1. In Client for Office, open the document by doing one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open File
(Read-Only).

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use the tree in the Home pane to navigate to and select the document.
b.  Click the down arrow on the Open button and choose Open Read-Only from the list.

2. On the Teamcenter tab of the Office ribbon, click Markup [ to display the markup comments and
the Teamcenter Markup Manager pane.

3. (Optional) Arrange comments in the details list.
4. In the comment details list, select the markup you want to review.

The selected markup is highlighted in the Word document.
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Note:

Word displays Teamcenter Markup Manager comments according to your Tracking settings
on the Review tab.

5. If other users may have added comments to the document since you opened it, click Load at the
top of the Teamcenter Markup Manager pane to see the new comments.

6. When you are done viewing the comments, close the document.
If a message appears asking you if you want to save changes to Teamcenter, click No.
Modify comment text

Users in both the author and reviewer roles can modify their own comments; however, only users in the
author role can modify other users' comments.

Note:

Modifications made using Word's built-in reviewing features are not saved in Teamcenter.

1. In Client for Office, open the document in either the reviewer role or the author role:
To open in the reviewer role, do one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open File
(Read-Only).

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use the tree in the Home pane to navigate to and select the document.
b.  Click the down arrow on the Open button and choose Open Read-Only from the list.

To open in the author role, do one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open and
Check-Out File.

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use tree in the Home pane to navigate to and select the document.

b.  Click the down arrow on the Open button and choose Open and Check-Out File from the
list.
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On the Teamcenter tab of the Office ribbon, click Markup > to display the Teamcenter Markup
Manager pane.

In the details list, select the comment whose text you want to modify.

You can select two or more comments with Read/Write access, using the standard Windows
functions for multiple selection.

Right-click the selection and choose Modify selected markups.

Note:

This option is unavailable if the selection contains General comments whose symbols
indicate Read-only access (&3).

In the text box for the comment, modify the text as necessary.
You can enter multiple lines of text by pressing Enter to start each new line.
Do the following for each comment with an open text box:
a. Place the cursor in the text box and enter the comment text.
You can enter multiple lines of text by pressing Enter to start each new line.
b.  To commit your changes, [ next to the text box.
To cancel your changes, click () next to the text box.

The text box closes and the modified comment is displayed in the details list; or, if you
cancelled your changes, the original text is displayed.

Click Save/Extract in the Teamcenter Markup Manager pane.
The markup comments are saved to Teamcenter.
Close the document.

If a message appears asking you if you want to save changes to the document, do one of the
following:

» (Reviewer role) To save a copy of the document to your local drive for your personal use, click
Yes, and choose the location where you want to save it. Since the document is opened as
read-only, you cannot save the document to Teamcenter.
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(Author role) To save to Teamcenter any changes you made to the document content, click Yes,
and in the Confirm Check-In dialog box, click Yes.

* To close the document without saving, click No.
Make comments visible or hidden for other users

Users in both the author and reviewer roles can make their comments visible or hidden to other users;
however, only users in the author role can change how other users' comments appear.

1. In Client for Office, open the document in either the reviewer role or the author role:
To open in the reviewer role, do one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open File
(Read-Only).

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use the tree in the Home pane to navigate to and select the document.
b.  Click the down arrow on the Open button and choose Open Read-Only from the list.

To open in the author role, do one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open and
Check-Out File.

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use tree in the Home pane to navigate to and select the document.

b.  Click the down arrow on the Open button and choose Open and Check-Out File from the
list.

2. Onthe Teamcenter tab of the Office ribbon, click Markup [ to display the Teamcenter Markup
Manager pane.

3. Inthe details list, select the comment you want to make visible or hidden to other users.

You can select two or more comments using the standard Windows functions for multiple
selection.

4. Right-click the selection and choose one of the following:

» Set selected markups as Hidden
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The markups are visible only to you as the comment owner.

This option is unavailable when the entire selection consists of comments whose current type is
Hidden.

* Set selected markups as General
The markups are visible to all users.

This option is unavailable when the entire selection consists of comments whose current type is
General.

Note:

If you select more than one comment, and some comments have Read-only access, only the
comments with Read/Write access are modified.

_|

he details list displays the symbols for the new types.

Note:

If the sort key is Arranged by ->Type, the details list re-sorts the comments within the new
type.

Click Save/Extract in the Teamcenter Markup Manager pane.
The changes to the markup comments are saved to Teamcenter.

(Author role) Since the Save/Extract feature clears the markup comments from the document,
if you want other users to see the markup comments, click Load to show the comments in the
document.

Close the document.

If a message appears asking you if you want to save changes to the document, do one of the
following:

* (Reviewer role) To save a copy of the document to your local drive for your personal use, click
Yes, and choose the location where you want to save it. Since the document is opened as
read-only, you cannot save the document to Teamcenter.

(Author role) To save to Teamcenter any changes you made to the document content, click Yes,
and in the Confirm Check-In dialog box, click Yes.

* To close the document without saving, click No.
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Delete comments

Users in both the author and reviewer roles can delete their comments; however, only users in the

author role can delete other users' comments.

In Client for Office, open the document in either the reviewer role or the author role:
To open in the reviewer role, do one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open File
(Read-Only).

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use the tree in the Home pane to navigate to and select the document.
b.  Click the down arrow on the Open button and choose Open Read-Only from the list.

To open in the author role, do one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open and
Check-Out File.

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use tree in the Home pane to navigate to and select the document.

b.  Click the down arrow on the Open button and choose Open and Check-Out File from the
list.

On the Teamcenter tab of the Office ribbon, click Markup 5 to display the Teamcenter Markup
Manager pane.

In the details list, select the comment you want to delete.

You can select two or more comments using the standard Windows functions for multiple
selection.

Right-click the selection and choose Delete selected markups.

The comments are deleted from the details list and from the document. If you select more than
one comment, and some comments have Read-only access, only the comments with Read/Write
access are deleted.

Click Save/Extract in the Teamcenter Markup Manager pane.
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The new list of markup comments is saved to Teamcenter.

6. (Author role) Since the Save/Extract feature clears the markup comments from the document,
if you want other users to see the markup comments, click Load to show the comments in the
document.

7. Close the document.

8. If a message appears asking you if you want to save changes to the document, do one of the
following:

» (Reviewer role) To save a copy of the document to your local drive for your personal use, click
Yes, and choose the location where you want to save it. Since the document is opened as
read-only, you cannot save the document to Teamcenter.

(Author role) To save to Teamcenter any changes you made to the document content, click Yes,
and in the Confirm Check-In dialog box, click Yes.

* To close the document without saving, click No.
Revise a document according to reviewer comments

During or at the end of a review cycle, an author uses comments from the reviewers as a guide in
revising the document.

For example, the comments may call for any or all of the following revisions:

Edit the document content.

Delete comments for which revisions are complete.

Add or modify comments for release with the document.
1. InClient for Office, open the document in the author role by doing one of the following:

* In the Folder View or the Navigation view, right-click the document and choose Open and
Check-Out File.

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use tree in the Home pane to navigate to and select the document.

b.  Click the down arrow on the Open button and choose Open and Check-Out File from the
list.
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8.

On the Teamcenter tab of the Office ribbon, click Markup > to display the Teamcenter Markup
Manager pane.

If other users may have added comments to the document since you opened it, click Load at the
top of the Teamcenter Markup Manager pane to see the new comments.

Revise the document as necessary, including any or all of the following tasks:

Edit the document content using standard Word features.

* Add comments to the document.

* Modify comment text.

¢ Make comments visible or hidden for other users.

* Apply disposition comments and status to markup comments.
Click Save/Extract at the top of the Teamcenter Markup Manager pane.

The changes you made to markup comments are saved to Teamcenter, and the comments are
cleared from the document, which hides them from other users who open the document as a
reviewer or reader.

Click Save to save any changes you made to the document.

When a message appears asking you if you want to check in the document to Teamcenter, click
Yes.

Close the document.

Applying disposition comments and status to markups

Process for applying dispositions to markup comments

Client for Office enables you to add and review markup comments in Microsoft Office Word documents
during content reviews. Word documents are stored in Teamcenter and can be attached to items and
used in workflows.

Dispositions provide a way to track the status of and comment on reviewers' markup comments. For
example, you can add a disposition to a comment with status of Rejected and add a disposition
comment such as, Out of the scope of this project.

Users in the author role can add and update disposition comments and apply a disposition status on
review comment markups in the Teamcenter Markup Manager pane, comments details list. You can
also generate a report of the disposition comments and status.
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Note:

This content review functionality differs from adding markup comments to requirements objects
using live Word as the interface to the content of the requirement objects, for which dispositions
are not available.

Your business process may vary, but a typical process for adding and updating disposition comments and
applying disposition status to markups includes the following steps:

1. Check out the review document.

2. Update the document’s content for the related reviewer’s markup.

3. Add adisposition comment on the related reviewer’s markup and include a status.
4. Generate a report of the markups and the disposition of each.

5. Save and extract the markups and dispositions.

6. Checkin the document.

Work with dispositions for markup comments

Open a document to work with dispositions

1. In Client for Office, do one of the following to open the document in the author role:

* In the Folder View or the Navigation view, right-click the document and choose Open and
Check-Out File.

* On the Teamcenter tab of the ribbon, click Open to display the Teamcenter Open dialog box.
a. Use tree in the Home pane to navigate to and select the document.

b.  Click the down arrow on the Open button and choose Open and Check-Out File from the
list.

2. Onthe Teamcenter tab of the Office ribbon, click Markup [ to display the Teamcenter Markup
Manager pane.

Create a disposition comment

1. Inthe comment details list, right-click a markup comment, and choose Disposition on a selected
markup.

5-25



_ 5. Conducting content reviews using Client for Office

2. Inthe box, enter a comment.
3. Click B next to the box.

The disposition is added to the markup comment, and the disposition status is set to None [_].
Set or change the status of a disposition

1. In the comment details list, right-click the markup comment with the disposition, and choose
Update disposition status.

2. Select one of the statuses from the list:

* [Z1None

* [ Accepted

* A Cancelled

* = Completed

* [#l Opened

 [M Rejected
3. Click [ next to the box.

The disposition status is added to the markup comment.
Update a disposition comment

1. In the comment details list, right-click the markup comment with the disposition, and choose
Disposition on a selected markup.

2. Inthe box, update the comment.
3. Click B next to the box.

The disposition is updated.
Delete a disposition comment

1. In the comment details list, right-click the markup comment with the disposition, and choose
Disposition on a selected markup.
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2. Inthe box, clear the comment.
3.  Click [ next to the box.
The disposition is removed from the markup comment.
Save and check in a document with dispositions
1.  Click Save/Extract in the Teamcenter Markup Manager pane.

The dispositions and any updated markup comments are saved to Teamcenter. The dispositions and
markup comments are also cleared from the document.

2. Close the document.

3. If a message appears asking you if you want to save changes to the document, do one of the
following:

* To save to Teamcenter any changes you made to the document content, click Yes, and in the
Confirm Check-In dialog box, click Yes.

* To close the document without saving, click No.

5-27



_ 5. Conducting content reviews using Client for Office

5-28 Teamcenter Client for Microsoft Office, Teamcenter 2412
© 2025 Siemens



6. View and markup PDF files from
Microsoft Outlook

Prerequisites for viewing and marking up PDF files

From Microsoft Outlook, you can view and markup a PDF file stored in Teamcenter without leaving the
Outlook application. You use the view and markup capability provided by the Adobe Acrobat/Reader
application to markup the PDF document. Markups are useful for making comments that you do not
want to appear in the published PDF file.

You must install the Acrobat/Reader Plugin feature to view and markup, and sign PDF files.

The Outlook_ViewMarkup_Launchable_TcTypes preference defines the Teamcenter types that can
launch for view and markup from Microsoft Outlook.

Process for viewing and marking up PDF files

Viewing and marking up a PDF file from Microsoft Outlook is part of a multi-step process:

m o A
5 A
1. From Outlook, — 5 | oo Datasetis | ¥ 3. Markup PDF »
T PDF dataset for launched usi document usin
el ng 2 4, Commit changes
= wiew and Adabe Adobe to T te
eamcenter. markup. Acrobat/Reader. AcrobatiReader. CAMEENIer:
r) A - — - - ’ -

1. From Outlook, navigate to the PDF file in Teamcenter.

From the Teamcenter ribbon in Outlook, browse and locate the PDF file that you want to view and
markup.

2. Launch the PDF file for view and markup.

Right-click the PDF file in the search results and choose View/Markup. The PDF file is automatically
launched using Adobe Acrobat/Reader.

3.  Markup PDF document using Adobe Acrobat Reader.
4. Commit changes to Teamcenter.

From Abobe Acrobat Reader, save the PDF document to commit the markup changes to
Teamcenter.
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View and markup a PDF file

1. From the Office application in Microsoft Outlook, navigate to and select the PDF file you want to
view and markup.

2. Right-click and choose View/Markup.

The PDF document is launched from Microsoft Outlook using the Adobe Acrobat/Reader
application.

3. Using the Adobe Acrobat/Reader application, mark up the PDF document as desired.
4. From the Adobe Acrobat/Reader application, choose File—>Save.

The marked up changes are committed to Teamcenter.
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Outlook

Prerequisites for digitally signing PDF files

From Microsoft Outlook, you can digitally sign a PDF file stored in Teamcenter without leaving the
Outlook application. Digital signatures uniquely identify the person signing the PDF document. Using
digital signing, reviewers can sign an electronic version of your document, instead of a printed one. For
example, you can have reviewers digitally sign your PDF documents to approve them.

You must install the Acrobat/Reader Plugin feature to view and markup, and sign PDF files.

The Outlook_Sign_Launchable_TcTypes preference defines the Teamcenter object types you can
launch for digitally signing from Microsoft Outlook.

Process for digitally signing PDF files

From Microsoft Outlook, you can digitally sign a PDF file stored in Teamcenter without leaving Outlook.

Digitally signing a PDF file is part of a multi-step process:

AN O ]

1. From Outlook, — . PN o . — .
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1. From Outlook, navigate to the PDF file in Teamcenter.

From the Teamcenter ribbon in Outlook, browse and locate the PDF file that you want to digitally
sign.

2. Launch the PDF file for digitally signing.
Right-click the PDF file in the search results and choose Sign.
The following occurs:

* The PDF file is automatically launched using Adobe Acrobat/Reader.
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* The PDF file is checked out in Teamcenter for signing.

After you have checked out the PDF file for signing, you have the option of canceling the
signature, which cancels the checkout.

You cannot check out, check in, or cancel the checkout of the PDF file when it is checked out for
sign.

3. Digitally sign the PDF document using Adobe Acrobat Reader.

4. Commit changes to Teamcenter.
From Abobe Acrobat Reader, save the PDF document to commit the signature to Teamcenter.
The following occurs after you commit the changes to Teamcenter:

* The users’ digital signature is stored in the PDF document.

* As the following figure shows, the Signed By relation is created between the PDF document and
the signing user to record the person who digitally signed the PDF file and the date and time
when it was signed.

PDF dataset [ ‘

Digitally sign a PDF file

1. From the Office application in Microsoft Outlook, navigate to and select the PDF file you want to
digitally sign.

2. Right-click and choose Sign.

The PDF document is launched from Microsoft Outlook using the Adobe Acrobat/Reader application
and the PDF file is checked out in Teamcenter.

3. Using the Adobe Acrobat/Reader application, digitally sign the PDF document.
4.  From the Adobe Acrobat/Reader application, choose File—>Save.

The signed document is checked in and the changes are committed to Teamcenter.
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Cancel the signature on a PDF file

1. From the Office application in Microsoft Outlook, navigate to and select the signed PDF file for
which you want to cancel the signature.

2. Right-click and choose Cancel signing.

The PDF file is no longer checked out for signing.

View the digital signature history of a PDF file

1. From the Office application in Microsoft Outlook, navigate to and select the PDF file for which you
want to view the digital signature history.

2. Right-click and choose View Properties.

3. Inthe Properties Display dialog box, navigate to the Signed by property to display the list of users
who digitally signed the PDF file.
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8. Managing Teamcenter workflow tasks
using Client for Office

Overview of managing Teamcenter workflow tasks

Workflow is the automation of business processes to accomplish an objective. A workflow process is
initiated by a user, and workflow tasks are assigned to users. Workflows pass documents, information,
and tasks between participants during the completion of a particular process.

Office suite

2 kL E

Outlook Powerpoint Word Excel

Execute tasks

Create part

Teamcenter workflow

In Client for Office, you can manage workflow tasks by doing the following:
* Browse your worklist.

Your worklist inbox contains the following folders:

* Tasks to Perform

Any tasks you are assigned appear in the Tasks to Perform folder. Once the completion criteria
of a task are met (for example, the required quorum of approvals for a perform-signoffs task are
granted), the task is complete and is removed from the folder.
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¢ Tasks to Track

If you initiate a process, but are not responsible for the currently active task, Teamcenter places
the task in the Tasks to Track folder. When the completion criteria of the task are met, the task is
complete and is removed from the folder.

* Initiate a workflow process for a Teamcenter object.

* When you initiate a workflow process, you are the process owner.

* The root task of the process is placed in your Inbox, and you become the responsible party.
* Perform workflow tasks.

* Pending tasks are in the Tasks to Perform folder.

* Tasks you have performed are in the Tasks to Track folder.
* Reassign and delegate tasks.

* Reassign a task to transfer ownership of the parent task to the selected user and make that user the

responsible party for the task.

Note:

Reassigning a task does not transfer your signoff responsibility.

* Delegate your signoff responsibility to authorize another user to perform a perform-signoffs

subtask that is currently assigned to you.

If you are selected to a signoff team based on your inclusion under a signoff profile, you can only
delegate the perform-signoffs subtask to another user who can match your signoff profile group
and role.

Otherwise, you can delegate the perform-signoffs subtask to any other user.
Reassign and delegate tasks using resource pools.
You can use resource pools to balance workflow tasks between groups of users.

m Resource pools let you balance workflow task assignments. They allow open-ended assignments,
permitting any user to accept responsibility for a task that is assigned to a group, role, or a role in
a group.
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m Users have the option of subscribing to specific resource pool inboxes; however, they can only
perform tasks if they are valid members of the group or are assigned the appropriate role. You
can subscribe to resource pools using the Teamcenter rich client.

m Tasks assigned to a resource pool appear in the Tasks to Perform folder and the Tasks to Track
folder of the appropriate resource pool inbox. Any member of the resource pool can then accept
responsibility and perform the task.

* Select a sign-off team.

For a select-signoff-team task, your responsibility is to specify the users who are required to sign off
the target object of the task.

¢ View all reviewer comments for a workflow task.

Note:

With Outlook and Teamcenter working together, you can access your workflow tasks, execute the
tasks, and approve or reject the tasks without ever opening Teamcenter. Procedures for working
with Outlook and Teamcenter workflow are slightly different than working with the other Client for
Microsoft Office applications.

Workflow tasks

Workflow task types

A workflow task template is a blueprint of a workflow task. A task is a fundamental building block
used to construct a workflow process. Each task defines a set of actions, rules, and resources used to
accomplish that task.

Tasks Definition

Do Task This task has two options if at least one failure path is
configured. Complete confirms the completion of a task
and triggers the branching to a success path. Unable
to Complete indicates the task is unable to complete,
for various reasons. The task uses the EPM-hold handler
to prevent the task from automatically completing when
started.

Review Task This task uses the select-signoff-team and perform-
signoffs subtasks, each of which has its own dialog box.

Route Task This task is the electronic equivalent of a routing sheet;
the task is used to assign different responsibilities for the
same task to multiple users. After you complete a Route
task, users are notified of their tasks using Teamcenter
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Tasks

Custom form task

Condition Task

Workflow task buttons

Definition

mail. This task uses the Review, Acknowledge, and
Notify subtasks, each of which has its own dialog box.

This task carries your custom forms or other site-specific
tasks for users to complete. You use the EPM-display-
form handler to display the specified forms attached to

a specified custom task and EPM-create-form handler

to create an instance of a specified form and attach the
form to the specified task. The EPM-display-form handler
creates the form when the Start action is initiated, the
EPM-display-form handler displays the form when the
Perform action is initiated, and the EPM-hold handler to
prevent the task from automatically completing, allowing
the form to be completed by the user.

This task branches a workflow according to defined query
criteria. It requires that the succeeding task contains a
check-condition handler that accepts a Boolean value of
either True or False.

The workflow process template specifies the buttons and boxes that are displayed for the selected

workflow task.

* Some buttons are specific to certain task types.

* Button and box elements may vary among tasks of the same type.

* Required elements for the selected task are marked by an asterisk (*) in the worklist view.

Do task buttons

The following elements are displayed when you perform a Do task.

Elements

Refresh button

Comments box

Password box

Description

Synchronizes the Perform Workflow Task view
with the latest data in Teamcenter.

Describes additional information about the task.

Your Teamcenter password.

This box displays if the process template specifies
user authentication.
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Elements Description

Complete button Indicates that you completed the task. The task is
removed from your Tasks to Perform folder.

Reassign button Displays the Reassign dialog box, where you can
change the role of responsible party from you to
another user. The task is moved to your Tasks to
Track folder.

Select signoff task buttons

The following elements are displayed when you perform a select-signoff-team g, task.

Elements Description

Refresh button Synchronizes the Perform Workflow Task view
with the latest data in Teamcenter.

Comments box Describes additional information about the task.

Password box Your Teamcenter password.

This box displays if the process template specifies
user authentication.

Select Signoff Team button Displays the Select Signoff Team dialog box,
where you specify the users who need to review,
acknowledge, or be notified of the task. This task
is a subtask for the Review, Acknowledge, and
Route tasks.

For the Review task, you specify the users needed
to review the task.

For the Acknowledge task, you specify the users
needed to acknowledge the task.

For the Route task, you can specify the action and
the users needed to perform the task. You can set
the action to Review, Acknowledge or Notify.

Reassign button Displays the Reassign dialog box, where you can
change the role of responsible party from you to
another user. The task is moved to your Tasks to
Track folder.

Acknowledge task buttons

The following elements are displayed when you perform an Acknowledge task.
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The following elements are displayed from the perform-signoff-team subtask [7] of the Acknowledge

task.

Elements

Refresh button

Password box

Signoff Task and View all Reviews Decisions
button

Review task buttons

Description

Synchronizes the Perform Workflow Task view
with the latest data in Teamcenter.

Your Teamcenter password.

This box displays if the process template specifies
user authentication.

Displays the Task Instructions dialog box with the
following elements:

* Acknowledged button
Indicates that you received the task and
reviewed the document. The task is removed
from your Tasks to Perform folder.

* Not Acknowledged button
Indicates that you received the task but did not
review the document. The task remains in your
Tasks to Perform folder.

* Delegate button
Displays the Delegate dialog box, where you
can assign task responsibility to another user.
The task is moved to your Tasks to Track folder.

¢ Comments box
Describes additional information about the task.

The following elements are displayed when you perform a Review task.

The following elements are displayed from the perform-signoff-team subtask [] of the Review task.

Elements

Refresh button

Password box

Description

Synchronizes the Perform Workflow Task view
with the latest data in Teamcenter.

Your Teamcenter password.
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Signoff Task and View all Reviews Decisions
button

Condition task buttons

Condition task buttons

Description

This box displays if the process template specifies
user authentication.

Displays the Task Instructions dialog box with the
following elements:

* Approve button
Indicates that you received the task and
approved the document. The task is removed
from your Tasks to Perform folder.

* Reject button
Indicates that you received the task but rejected
the document. The task is removed from your
Tasks to Perform folder.

* No Decision button
Indicates that you received the task but did not
review the document. The task remains in your
Tasks to Perform folder.

* Delegate button
Displays the Delegate dialog box, where you
can assign task responsibility to another user.
The task is moved to your Tasks to Track folder.

¢ Comments box

Describes additional information about the task.

The following elements are displayed when you perform a Condition task.

Elements

Condition path button

Description

Indicates the workflow process continues along
the branch specified by the condition path
button based on the requirements listed in the
Instructions box.

For example, a False button indicates the
workflow process continues along the false
branch, and a True button indicates the workflow
process continues along the true branch.
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Elements

Unset button

Unable to Complete button

Reassign button

Form task buttons

Description

The task is removed from your Tasks to Perform
folder.

Prevents the task from completing and pauses the
workflow process.

Indicates that the task cannot be done. The task is
removed from your Tasks to Perform folder.

This button displays if the process template
specifies a task failure path.

Displays the Reassign dialog box, where you can
change the role of responsible party from you to
another user. The task is moved to your Tasks to
Track folder.

The following elements are displayed when you perform a Form task.

Elements

Custom form fields

Complete button

Unable to Complete button

Reassign button

Description

Fields that are required to be filled in depending on
the custom form carried with the task.

Indicates that you did the task. The task is removed
from your Tasks to Perform folder.

Indicates that the task cannot be done. The task is
removed from your Tasks to Perform folder.

This button displays if the process template
specifies a task failure path.

Displays the Reassign dialog box, where you can
change the role of responsible party from you to
another user. The task is moved to your Tasks to
Track folder.

Browsing your worklist for assigned tasks

Introduction to browsing your worklist
Your worklist inboxes contain the following folders:

¢ Tasks to Perform

8-8



Browse your worklist using the Folder View _

Any tasks you are assigned appear in the Tasks to Perform folder. Once the completion criteria of a
task are met (for example, the required quorum of approvals for a perform-signoffs task have been
granted), the task is complete and is removed from the folder.

¢ Tasks to Track

If you initiate a workflow process, but are not responsible for the currently active task, Teamcenter
places the task in the Tasks to Track folder. When the completion criteria of the task are met, the task
is complete and is removed from the folder.

You can browse your worklist to display your inboxes and any subscribed resource pool inboxes. You
must subscribe to resource pool inboxes, but you can only perform tasks from the resource pool if you
are a valid member of the group or are assigned the appropriate role. Any member of the resource
pool can then accept responsibility and perform the task. You can subscribe to resource pools using the
Teamcenter rich client.

Browse your worklist using the Folder View
1.  Click the Teamcenter tab—->Navigation and View group—>Navigate and choose Folder View.
The Folder View displays your Home folder, your inbox, and your saved searches.

2. Click the - button to the left of My Worklist to expand your worklist.

Navigation - Folder View v X
Enter Item ID . L -
A&k Home
& My Worklist

L0 My Saved Searches

Your inbox and any resource pool inboxes that you are subscribed to are displayed as shown in the
following example.

Navigation - Folder View v X
Enter Item ID . L -
A&k Home
&5 My Worklist

&l Bill (Bill) Inbox(1) «— user inbox
&5 Design/* Inbox(1) «—resource pool inbox

3. Expand the inbox you want to display the tasks for.
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The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation - Folder View v X
Enter Item ID . L -
A& Home
& My Worklist

& Bill (Bill) Inbox(1)
| Tasks to Perform
= Tasks to Track

Expand the task folders to display the tasks and the tasks to display the targets.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation - Folder View v X
Enter ltem ID... O
i» Home
&5 My Worklist

& Bill (Bill) Inbox(1)
4 =) Tasks to Perform
d REQ-1 (perform-signoffs)
£ REQ-1 (perform-signoffs) <
= Tasks to Track
You can do the following for each task:
* To perform the task, right-click the task and choose View/Perform Task.

The Perform Workflow Task view displays.

* Toinsert the task object data into an open Office document, right-click the task and choose
Insert.

You can right-click a task target and choose one of the following:
* Choose Properties to view the properties in the Properties Display view.
* Choose Check-In/Out to check in or check out the target in the Teamcenter Check-In/Out view.

* Choose Insert to insert the object data into an open Office document.




Browse your worklist using the Browse view _

* Choose Open File (Read-Only) or Open and Check-Out File to open a target Office document
for viewing or editing.

Browse your worklist using the Browse view
1.  Click the Teamcenter tab->Navigation and View group—>Navigate and choose Browse.
The Browse view displays your Home folder, your inbox, and your saved searches.

2. Click My Worklist to expand your worklist.

Navigation v X
Enter ltem ID_. L -
Start >
i# Home
& My Worklist

SOMy Saved Searches

Your inbox and any resource pool inboxes that you are subscribed to are displayed as shown in the
following example.

Navigation v X

Enter ltem ID... ( 4 Y

Start >My Worklist>
& Bill (Bill) Inbox(1) «=— user inbox
& Design/* Inbox(1) «— resource pool inbox

3. Click the inbox you want to display the tasks for.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following

example.
Navigation v X
[ Enter Item ID . L -

Start > My Worklist> Chester (Chester) Inbox(1)
El Tasks to Perform

E] Tasks to Track

4.  Click the task folders to expand them and view your tasks.
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Note:

To return to a previous level in the Navigation view, click the level in the Start line at the top
of the view.

Your tasks are displayed as shown in the following example.

Navigation v X

Enter ltem ID... O

Start > My Worklist> Chester (Chester) Inbox(1) > Tasks to Perform
1% REQ-1 (select-signoff-team)
REQ-2 (perform-signoffs)
5.  Click the tasks to display the targets of the task.

Your task targets are displayed as shown in the following example.

Navigation v X

Enter ltem ID . Q "‘

Start > My Worklist> Chester (Chester) Inbox(1) > Tasks to Perform >select-signoff-team >
# REQ-1 (select-signoff-team) @

6. You can do the following for each task:
* To perform the task, right-click the task and choose View/Perform Task.
The Perform Workflow Task view displays.

* To insert the task object data into an open Office document, right-click the task and choose
Insert.

7. You can right-click a task target and choose one of the following:
* Choose Properties to view the properties in the Properties Display view.
* Choose Check-In/Out to check in or check out the target in the Teamcenter Check-In/Out view.
* Choose Insert to insert the object data into an open Office document.

* Choose Open File (Read-Only) or Open and Check-Out File to open a target Office document
for viewing or editing.
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Browse your worklist using the My Worklist view
1.  Click the Teamcenter tab->Workflow group—->My Worklist .

The My Worklist view automatically navigates to your My Worklist folder and displays your
inboxes.

Your inbox and any resource pool inboxes that you are subscribed to are displayed as shown in the
following example.

Navigation
Start > My Worklist>
& Bill (Bill) Inbox(1) «— user inbox
&y Design/* Inbox(1) «— resource pool inbox

2.  Click the inbox you want to display the tasks for.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation
Start > My Worklist> Chester (Chester) Inbox(1)

E Tasks to Perform

E Tasks to Track

3. Click the task folders to display the tasks, and click the tasks to display the targets.
4. You can do the following for each task:
* To perform the task, right-click the task and choose View/Perform Task.
The Perform Workflow Task view displays.

* To insert the task object data into an open Office document, right-click the task and choose
Insert.

5. You can right-click a task target and choose one of the following:
* Choose Properties to view the properties in the Properties Display view.
* Choose Check-In/Out to check in or check out the target in the Teamcenter Check-In/Out view.

* Choose Insert to insert the object data into an open Office document.
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* Choose Open File (Read-Only) or Open and Check-Out File to open a target Office document
for viewing or editing.

Initiate a workflow process from Client for Office

Note:

* A Teamcenter object must be open in the active Office application, and that file must be saved.

* The open object can be either the process target or another Teamcenter document.

Caution:

To initiate a workflow process from an offline live Word document, you must synchronize the
document with Teamcenter.

Select the object in the Folder View, the Navigation view, the Search Results view, or the
Requirements pane.

The object can have an Office file type other than that of the active application.

Click New Workflow Process == on the Teamcenter ribbon, or right-click the object and choose
New Workflow Process.

The New Workflow Process dialog box displays.
Type a name for the new process in the Process Name box.
You can also type an optional description in the Description box.

In the Process Templates list, select the template to apply to the new process.

Note:

When All (the default) is selected, the Process Templates list shows all process templates.
You can click Assigned to populate the list with only those process templates that are
assigned to the object type.

Click OK to initiate the process.

The item revision containing the Office document is routed to the workflow as the target of the
new process.
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Perform a task

1. Browse to the task in the My Worklist view, the Navigation view, or the Folder View.
2. Right-click the task and choose View/Perform Task.
The Perform Workflow Task view displays.

3. Do the appropriate actions for the task, according to the elements displayed in the Perform
Workflow Task view.

Reassign or delegate a task

1. Browse to the task in the My Worklist view, the Navigation view, or the Folder View.
2. Right-click the task and choose View/Perform Task.

The Perform Workflow Task view displays.
3. Do one of the following:

* Click the Reassign button to display the Reassign dialog box.

* Click the Delegate button to display the Delegate dialog box.

4. Under Organization Profiles, expand the group and role nodes to display the user to whom you
want to reassign the task.

Tip:

You can quickly locate groups, roles, and users by using the controls at the bottom of the
dialog box:

* Type the group name in the box and click the Search for Group button.

* Type the role name in the box and click the Search for Role button.

* Type the user name in the box and click the Search for User button.

Then, expand the nodes to display the user.

You can restore the default settings by clicking Refresh.

5. Select the user and click OK.
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The task is moved to your Tasks to Track folder and is sent to the new owner's Tasks to Perform
folder.

Select a sign-off team
1. Browse to the task in the My Worklist view, the Navigation view, or the Folder View.
2. Right-click the task and choose View/Perform Task.
The Perform Workflow Task view displays.
3. Click the Select Signoff Team button to display the Select Signoff Team dialog box.

4. In the Organization Profiles section, expand the nodes to display the appropriate group, role, or
user.

Tip:

You can quickly locate groups, roles, and users by using the controls at the bottom of the
dialog box:

* Type the group name in the box and click the Search for Group button.

* Type the role name in the box and click the Search for Role button.

* Type the user name in the box and click the Search for User button.

Then, expand the nodes to display the user.

You can restore the default settings by clicking Refresh.

Note:

The Organization Profiles list must be created using the Teamcenter rich client.

5. In the Signoff Team section, select the Users node, and then do one or both of the following:
* To add a group, role, or user to the sign-off team:
a. Select the corresponding node under Organization Profiles.
b.  Click the left arrow in the center of the dialog box.

* To remove a group, role, or user from the sign-off team:




View workflow reviewer comments _

a. Select the corresponding node group, role, or user under the Users node in the Signoff
Team section.

b.  Click the right arrow in the center of the dialog box.

Repeat these steps to add or remove other users for the sign-off team.

View workflow reviewer comments

1. Browse to the task in the My Worklist view, the Navigation view, or the Folder View.
2. Right-click the task and choose View/Perform Task.
The Perform Workflow Task view displays.
3.  Click the Signoff Task and View all Reviews Decisions button.
4. From the Task instructions dialog box and click the = button under the Decision heading.

* Click the Approve button to approve the document. The task is removed from your Tasks to
Perform folder.

* Click the Reject button to reject the document. The task is removed from your Tasks to Perform
folder.

* Click the No Decision button to indicate you did not review the document. The task remains in
your Tasks to Perform folder.

5. Click the Delegate button if you want to assign the task responsibility to another user. The task is
moved to your Tasks to Track folder.

6. Type a commentin the Comments box to describes additional information about the task.

7.  Click OK.
Using Outlook to perform Teamcenter workflow tasks

Performing Teamcenter workflow tasks in Outlook

In Outlook, Client for Office incorporates Teamcenter workflow features through the Teamcenter
custom toolbar and Teamcenter commands on the Outlook Tools menu.

Outlook displays the Teamcenter tab to access your Teamcenter worklist and initiate a workflow.

When you browse your worklist, the following folders are displayed:
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¢ Tasks to Perform

Any tasks you are assigned appear in the Tasks to Perform folder. Once the completion criteria of a
task are met (for example, the required quorum of approvals for a perform-signoffs task have been
granted), the task is complete and is removed from the folder.

¢ Tasks to Track

If you initiate a process, but are not responsible for the currently active task, Teamcenter places
the task in the Tasks to Track folder. When the completion criteria of the task are met, the task is
complete and is removed from the folder.

You can also display your Teamcenter worklist tasks in your Outlook To-Do List. You use the command
Synchronize Teamcenter Tasks to synchronize your Teamcenter tasks to your Outlook tasks.

You can also use Outlook to do the following:

* Browse your worklist.

* Perform Teamcenter sign-offs.

* Send an Outlook message containing Teamcenter task data.

* Save an Outlook message in Teamcenter.

Browse your worklist using Outlook
Use one of the following methods to display your worklist in Outlook:
* Click the Teamcenter tab—->Navigation and View group->NavigateZ= and choose Browse.
The Browse view displays your Home folder, your inbox, and your saved searches.
1. Click My Worklist to expand your worklist.
Navigation
Start >
it Home
& My Worklist
L0 My Saved Searches

Your inbox and any resource pool inboxes that you are subscribed to are displayed as shown in
the following example.

Navigation
Start > My Worklist>




Browse your worklist using Outlook _

& Bill (Bill) Inbox(1) «— user inbox
& Design/* Inbox(1) «— resource pool inbox

2. Click the inbox you want to display the tasks for.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation

Start > My Worklist> Chester (Chester) Inbox(1)
== Tasks to Perform
=1 Tasks to Track

3. Click the task folders to expand them and view your tasks.

Note:

To return to a previous level in the Navigation view, click the level in the Start line at the
top of the view.

Your tasks are displayed as shown in the following example.
Navigation
Start > My Worklist> Chester (Chester) Inbox(1) > Tasks to Perform
2 REQ-1 (select-signoff-team)
REQ-2 (perform-signoffs)
4.  Click the tasks to display the targets of the task.
Your task targets are displayed as shown in the following example.
Navigation

Start > My Worklist> Chester (Chester) Inbox(1) > Tasks to Perform >select-signoff-team >
#*| REQ-1 (select-signoff-team) @

* Click the Teamcenter tab—>Navigation and View group—>NavigateZ and choose Folder View.
The Folder View displays your Home folder, your inbox, and your saved searches.
1. Click the - button to the left of My Worklist to expand your worklist.
Navigation - Folder View
ik Home

& My Worklist
C,, My Saved Searches
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Your inbox and any resource pool inboxes that you are subscribed to are displayed as shown in
the following example.

Navigation - Folder View
i» Home
4 % My Worklist
& Bill (Bill) Inbox(1) «— user inbox
& Design/* Inbox(1) «— resource pool inbox

Expand the inbox you want to display the tasks for.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation - Folder View
i# Home
4 % My Worklist
4 %5 Bill (Bill) Inbox(1)
= Tasks to Perform
= Tasks to Track

Expand the task folders to display the tasks and the tasks to display the targets.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation - Folder View
4% Home
4 % My Worklist
4 %5 Bill (Bill) Inbox(1)
4 1 Tasks to Perform
d REQ-1 (perform-signoffs)
£ REQ-1 (perform-signoffs) <
= Tasks to Track

* Click the Teamcenter tab—->Workflow group—->My Worklist .
The My Worklist view automatically navigates to your My Worklist folder and displays your inboxes.

Your inbox and any resource pool inboxes that you are subscribed to are displayed as the example
shows below:

Navigation
Start > My Worklist>
& Bill (Bill) Inbox(1) «— user inbox
& Design/* Inbox(1) «— resource pool inbox
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1.  Click the inbox you want to display the tasks for.

The Tasks to Perform and the Tasks to Track folders are displayed as shown in the following
example.

Navigation

Start > My Worklist> Chester (Chester) Inbox(1)
i Tasks to Perform
= Tasks to Track

2.  Click the task folders to display the tasks, and click the tasks to display the targets.

Display your Teamcenter workflow tasks
1. In Outlook, click the Tasks button at the bottom of the navigation pane.
The contents of your Teamcenter inbox are displayed along with your Outlook tasks.
2. Todisplay your to-do list:
a. Choose View—To-Do Bar and select Normal and Task List.
b.  Under My Tasks, select To-Do List.
The contents of your Teamcenter inbox are displayed in your to-do list.

3. Double-click the task in your task list or to-do list to display the task information and the related
attachments.

Update your Teamcenter worklist
1. Display your Teamcenter tasks in your Outlook To-Do list or Tasks list.
2. Click the Teamcenter tab->Workflow group—>Synchronize Tasks .

Depending on the current contents in Teamcenter, tasks are added to or deleted from your task
lists.

Perform Teamcenter sign-offs

1. With your Teamcenter tasks displayed, do one of the following to open a (perform-signoffs) task:

* In the Outlook Tasks list or the To-Do List, double-click the task to open it in a separate Outlook
task window.
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Note:

In the separate window, click the Perform Task button on the Teamcenter ribbon to open
the Perform Workflow Task view.

* In the To-Do List, click the task to open it in the Outlook reading pane.

2. Use the elements in the separate window or the Outlook reading pane to do the appropriate
actions for the task type.

When the sign-off is complete, the task is removed from the Teamcenter Tasks to Perform
category.

Open an Outlook message stored in Teamcenter

1. Select the Teamcenter tab—>Navigation and View group—>Navigate and choose Browse or Folder
view.

The Teamcenter folders are displayed.
2. Expand your Home folder and navigate to the Outlook dataset.

3. Right-click the message and choose Open File (Read-Only) or Open and Check-Out File.

Note:

To edit the message, you must reply to or forward the message. Then, save the changes as a
new message in Teamcenter.

Send an Outlook message containing Teamcenter task data
1. Open the message in Outlook.
You can use a new message, a reply to a message, or a message that you forward.
2. Browse your Teamcenter worklist to display your Tasks to Perform and Tasks to Track folders.
3. Expand your inbox to display the Tasks to Perform and Tasks to Track folders.

4. Click or expand a task folder to display the individual tasks and navigate to the task you want to
insert as part of the message.

5. Place the cursor at the insertion point in the message.

6. Right-click the task and choose Insert.
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Note:

You can choose data insertion options and the columns to insert.

The data appears at the cursor location in the message.
7. Send the message.
Save an Outlook message in Teamcenter
1. Open the Outlook message you want to save.
2. Click the Teamcenter tab—>Data Management group—->Save As—>Dataset.

3. Onthe left side of the Teamcenter Save As dialog box, navigate to the Teamcenter location where
you want to save the message.

4. Type the message name in the File Name box.
You can also enter an optional description in the Description box.
5. Click Save.
The message appears in the selected location.
Save a Microsoft Outlook message in Teamcenter in an email item revision
1.  Create an item of type Email. To do so, choose File->New—Item.
2. Inthe Create New Item dialog box, select Object Type as Email.
3. Specify other information such as Item Revision Information and click Finish.
4. Follow the steps listed above in this topic to save the email into the item revision.

The email message is saved under the selected email item revision.
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A. Known issues and workarounds for
Client for Office

Microsoft .NET framework WebBrowser control issues

The .NET framework provides a WebBrowser control that allows a C# application to host Web pages
and provide WebBrowser capabilities. This WebBrowser control is based on functionalities of Microsoft's
Internet Explorer.

The following are known issues with the WebBrowser control:
* The web client text box events are not recognized during typing or editing

When hosting the web client within Teamcenter Client for Office, certain web client text controls
perform filtering actions simultaneously as a user types in a text box. The filtering actions are
triggered by key press events. Due to issues with Microsoft's .NET WebBrowser control, which is used
by the Teamcenter Client for Office to host the web client, the key press events are not recognized
and the subsequent filtering actions do not happen. Similarly, when the web client property fields are
being edited, the background of the text box fields changes to indicate that the property is changed.
Again, within the Teamcenter Client for Office, the text box background color does not change since
the key press events are not being recognized by the .NET WebBrowser control.

How to work around or avoid

Click anywhere outside the text box to trigger the event required by the web client code to perform
the filtering or highlighting actions.

* Security interferes with downloading a file

Selecting the Download File button from the security pop-up at the top of the task pane causes
the browser to automatically reload the page. The user must reselect the Download File button.
However, after the page reloads, the web client loses the previous location information and users
cannot navigate back to their list of tasks.

How to work around or avoid
To view your tasks:

1. Close the task panel, or click the My Worklist button on the Teamcenter ribbon to close the
Worklist task pane.

2. Click the My Worklist button on the Teamcenter ribbon to reload the Worklist task pane.

* Changes to an edited property value may be lost
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When hosting the web client summary pages within Teamcenter Client for Office, and when editing
properties within the Summary page, changes made within the first text box are not recognized until
you click elsewhere on the page. If you were modifying a property value and then navigated away
from the page before the changes were saved, the changes are lost.

How to work around or avoid

After making edits in the first text box, click anywhere else on the page, including a second editable
text box. This highlights the edited text box in yellow, indicating that its value is modified. If you now
navigate away from the page, you are prompted to save or discard the edits.

Microsoft Excel Issues

* Download of an Excel file from the hosted web client dialog window is blocked

When Teamcenter Client for Microsoft Office is hosted on the web client and you attempt to download
a Microsoft Excel file from the web client user interface, the Excel file does not open until the pop-up
dialog window is closed. This is because the pop-up (modal) dialog window blocks the message
queue because of which Microsoft Excel is unable to open the downloaded spreadsheet.

How to work around or avoid

Close the popup dialog window, and Microsoft Excel opens the requested file.

* Teamcenter Client for Office context menus fail to work under certain conditions

From the navigation (Folder or Browse) task pane in Microsoft Excel, if you open a context menu for
the selected object, and it overlaps the spreadsheet window, the selection event might not work if the
mouse pointer is also over the spreadsheet window. The behavior is as if there is a hole in the context
menu and the click event happens in the spreadsheet cell directly underneath the context menu.

How to work around or avoid

As long as the navigation task pane is completely underneath the entire context menu, the menu
action works as expected. Expand the navigation task pane so that it is wide enough for the context
menu to entirely cover the navigation task pane.

Unable to edit the property of a checked-out object in Microsoft Excel

While using the Teamcenter Client for Microsoft Office (Office Client) Properties dialog window within
the Microsoft Excel application, you cannot modify or edit the text of the desired properties. The text
being typed is displayed in a cell of the Excel spreadsheet, rather than within the text field of the
Properties dialog window.

How to work around or avoid
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From the Properties dialog box, click the More Properties... link to display a modal dialog box, and
edit the desired properties from here.

* Interoperability issues with Microsoft Excel and editing properties in the Office Client

When editing properties of a checked-out Teamcenter object in the Summary view properties dialog
box within Microsoft Excel, entering values into a text box field causes the data to be typed into one of
the Excel cells, rather than in the property text box field.

How to work around or avoid

From the Properties Display dialog window, click the More Properties... link, which displays another
dialog window containing all the editable properties. From this dialog window, the properties can be
modified without interoperability issues that occur when using the Properties Display dialog window.

Microsoft Outlook Issues

* The delete key on the keyboard fails to delete emails in Outlook

After a user clicks any object in Teamcenter task pane in Microsoft Outlook, the Delete key on the
keyboard does not delete the selected email.

How to work around or avoid

Use the Delete option from the context menu. Microsoft technical support provides the following
workaround: Right-click any email to display the context menu, or switch tabs on the ribbon (in
Outlook 2010). After this, the Delete key works.

» Spacebar and backspace keys do not work in Outlook

Due to an unresolved issue within Microsoft Outlook, the Spacebar and Backspace keys do not work
within a hosted web client user interface when typing within text input fields such as comment boxes
and filters.

How to work around or avoid
Use the following keys:
» Use CTRL+Spacebar for the space character.

* Use SHIFT+Backspace to delete the last character.

General Hosted Web Client Issue

e Certain web client commands (buttons) are not available
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When the web client is hosted in Teamcenter Client for Office and displayed in narrow task panes,
certain web client commands (buttons) are not available in the user interface as displayed by default
in the task pane.

How to work around or avoid

Resizing the task pane to be wider than the default width exposes additional user interface elements,
including commands (buttons) that are missing in the narrow task pane view.
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